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Warranty and liability 
 

Note The Application Examples are not binding and do not claim to be complete regarding 
configuration, equipping and any eventuality. The Application Examples do not represent 
customer-specific solutions. They are only intended to provide support for typical 
applications. You are responsible for proper operation of the described products. These 
application examples do not relieve you of the responsibility to use safe practices in 
application, installation, operation and maintenance. When using these Application 
Examples, you recognize that we cannot be made liable for any damage/claims beyond 
the liability clause described. We reserve the right to make changes to these Application 
Examples at any time without prior notice. If there are any deviations between the 
recommendations provided in these Application Examples and other Siemens 
publications – e.g. Catalogs – the contents of the other documents have priority. 

We do not accept any liability for the information contained in this document. 
Any claims against us – based on whatever legal reason – resulting from the use of 
the examples, information, programs, engineering and performance data etc., 
described in this Application Example shall be excluded. Such an exclusion shall 
not apply in the case of mandatory liability, e.g. under the German Product Liability 
Act ("Produkthaftungsgesetz"), in case of intent, gross negligence, or injury of life, 
body or health, guarantee for the quality of a product, fraudulent concealment of a 
deficiency or breach of a condition which goes to the root of the contract 
("wesentliche Vertragspflichten"). The damages for a breach of a substantial 
contractual obligation are, however, limited to the foreseeable damage, typical for 
the type of contract, except in the event of intent or gross negligence or injury to 
life, body or health. The above provisions do not imply a change of the burden of 
proof to your detriment. 
Any form of duplication or distribution of these Application Examples or excerpts 
hereof is prohibited without the expressed consent of the Siemens AG. 

 

Security 
information 

Siemens provides products and solutions with industrial security functions that support the 
secure operation of plants, systems, machines, and networks. 

To protect plants, systems, machines, and networks against cyber threats, it is necessary 
to implement – and to continuously maintain – a holistic, state-of-the-art industrial security 
concept. Siemens’ products and solutions form only one element of such a concept. 

The Customer is responsible for preventing unauthorized access to plants, systems, 
machines, and networks. Systems, machines, and components should only be connected 
to the enterprise network or the internet if necessary and only to the extent necessary, 
and with appropriate protective measures (e.g., use of firewalls and network 
segmentation) in place.  

In addition, you should pay attention to Siemens’ recommendations on appropriate 
protective measures For more information about industrial security, go to 
http://www.siemens.com/industrialsecurity.  

The products and solutions of Siemens are being constantly developed further in order to 
render them even more secure. Siemens strongly recommends applying product updates 
as soon as they are available and to always use the latest product versions. The use of 
obsolete versions or versions that are no longer supported can increase the risk of cyber 
threats.  

In order to be informed about product updates at all times, be sure to subscribe to the 
Siemens Industrial Security RSS Feed on http://www.siemens.com/industrialsecurity. 

 

http://www.siemens.com/industrialsecurity
http://www.siemens.com/industrialsecurity
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1 Automation Task 

Introduction 

In facilities for the production of food or pharmaceutical products and its technical 
processes certain process steps, procedures and devices are repeated in the same 
or similar form.  

An important process in this regard is the automated cleaning of the apparatus and 
plant sections. 

This process is becoming more and more important with increasing plant size, 
since manual cleaning is no longer possible. One efficient process is the "Cleaning 
in Place" process, called "CIP Process" for short. 

The CIP process enables the cleaning of apparatus and plant sections in place. 
Disassembly is not necessary. As a result of this kind of automated cleaning, 
valuable working time is also saved. 

Overview of the automation task 

The CIP system is used for cleaning the other plant sections and fittings. The 
individual fittings are controlled by the automation program. 

Description of the automation task 

The fluids required for cleaning are prepared and held ready in the CIP system. 
There are different fluids for the different cleaning phases, and these must always 
be available in sufficient quantities. For this reason, the fill level in the storage 
tanks must be continuously monitored. If the levels are too low, fluid must be 
supplied to the tanks. 

In addition to the fill level, the quality of the fluid is also important. For this reason, 
the fluids in the tanks are controlled to a predefined temperature and concentration 
of detergent. Consequently the temperature and concentration are also 
continuously monitored and adjusted if necessary. 

A further task is to reuse as much cleaning fluid as possible after use. To this end, 
the quality in the return line is checked again. If the quality meets the 
specifications, the fluid will be automatically fed back to the tanks if these are not 
full. If the quality is not adequate or the tanks are full, the fluid is disposed of. 
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2 Automation Solution 

2.1 Overview of the complete solution 

The figure below shows schematically the structure of the solution: 
 

 

 

 

The Application Example “CIP" is implemented as a SIMATIC PCS 7 multiproject in 
accordance with ISA S88.01.  

The multiproject consists of an AS project (user program), an OS project 
(visualization with process pictures), as well as a SIMATIC BATCH system 
(production and cleaning recipes). 

The AS project was created using the APL library (Advanced Process Library), the 
BRAUMAT Library and SIMATIC BATCH blocks. 

Benefits 

This application offers you the following benefits: 

 Implementation of a CIP system conforming to ISA S88.01 

 Description of the most important automation functions for a CIP system 

Delimitation 

These “CIP” application examples do not cover the special case of a simultaneous 
cleaning of parts of the system. 
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Required knowledge 

Basic knowledge of the following specialist fields is a prerequisite: 

 Configuring with SIMATIC PCS 7, SIMATIC BATCH and the APL library 

 Knowledge of control technology 

 Basic knowledge of process technology 

2.2 Core functionality 

The "CIP" application example includes the user program with typical process tag 
types for a CIP system. 

The plant hierarchy (PH) is constructed according to ISA S88.01. The equipment 
modules necessary for the CIP system are defined. A plant overview picture and 
an overview picture with BATCH OCXn are included for operation.  

The figure below shows the BATCH OCX overview picture: 
 

 

 

A SIMATIC BATCH backup with a sample recipe is included for creating cleaning 
batches. 

Das Application example contains a simple simulation based on CFCs. The 
setpoints in the recipes are freely selected and may differ from one plant to 
another. The equipment modules and process tag types are used as an exemplary 
template and with plant-specific adaptations can be applied to a real production 
plant. 

The cleaning recipes must be created for the plant sections to be cleaned 
depending on construction and product. The example recipe merely describes the 
basic construction. 

 

Note The technical process in the CIP system is not simulated. 
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2.2.1 Description of the individual functions 

The individual parts of a CIP system are described in the following. The entry point 
is the process picture of the visualization screen. 
 

1

2

3
4

5

 

The process picture of the CIP system consists of the following main parts: 

1. CIP return modules 

2. Post-rinse tank 

3. Detergent tank 

4. Pre-rinse tank 

5. CIP supply modules 

 

1. Return 

The return is used to recover the used CIP fluids. Depending on the fill level in the 
tanks, the quality (temperature and detergent concentration) and also the current 
cleaning phase, the fluid is fed into the appropriate tanks or into the drain. This is 
done with the aid of sensors and valves. 

2. Post-rinse tank 

The cleaning fluid (e.g., water) for the final cleaning phase is stored in the post-
rinse tank. Fluid can be drawn off provided the level does not fall below the 
minimum fill level. 
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3. Detergent tank 

The detergent tank contains the cleaning fluid for the second cleaning phase. In 
this tank the fluid is heated up to the prescribed temperature and the necessary 
detergent concentration is established. The fluid is permanently pumped through a 
heating circuit so that it will always be at the specified temperature. Depending on 
the temperature, the detergent concentration is measured (based on its 
conductance). If the detergent concentration is too low, detergent is added. 

The detergent tank can also be filled with fresh water. This is possible when there 
is no CIP phase active, as the temperature and the concentration have to be 
adjusted to the correct values again. 

 

Note The detergent tank is used as an example of an acid or alkali tank. 

 

 

4. Pre-rinse tank 

The pre-rinse tank contains the cleaning fluid for the first cleaning phase. The fluid 
removes contamination and product residues from the pipes and apparatus. 

The tank is filled with fresh water or CIP fluid from the other cleaning phases. 

The tank can be filled provided the maximum fill level has not been reached. 

If a particular temperature and / or detergent concentration for the fluid is 
necessary for process-related reasons, the fluid can be prepared in the same way 
as described for the detergent tank. 

5. Preprocessing 

The CIP fluids are fed from the CIP tanks through the CIP supply line into the parts 
of the plant that are to be cleaned. The inflow from the tanks into the supply line is 
regulated via valves. The appropriate valve is opened depending on which 
cleaning phase is active. The flow rate is controlled by a pump. 

Before the fluid is drawn off, it is checked to confirm that it meets the quality 
requirements / that sufficient fluid is available. 

Other functions 

In addition to the "CIP" CIP system, the example project also contains the "MIX 
PLANT" plant section. This is used to demonstrate cleaning with a CIP system. 
The plant section consists of the mixer to be cleaned as well as the "TANK_IN" 
(tank inlet) and "TANK_OUT" (tank outlet) equipment modules.  

Advantages of this solution 

 A reduction of the knowledge necessary to develop applications 

 A reduction in the configuration effort 

 More flexible setup and adaptation due to technical functions 

 Standardized structures 



2 Automation Solution 

2.2 Core functionality 
 

CIP - Cleaning in Place 
Entry ID: 78463886,    V3.0,    09/2016   9 
 


 S

ie
m

e
n

s
 A

G
 2

0
1

6
 A

ll 
ri

g
h

ts
 r

e
s
e

rv
e

d
 

2.2.2 PI process screen 

The figure below shows the PI flow diagram of the CIP system. The process tag 
types that are contained in the project have been entered. 
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2.3 Hardware and software components used 

The example project has been created with the following components: 

Hardware components 

 

Component Note 

SIMATIC PCS 7 ES/OS IPC847D W7  For the PCS 7 V8.2 example project 

 

Note In case of different hardware, please observe the minimum requirements for 
installing the software components. The minimum requirements can be found in 
the Read Me file of the PCS 7. 

 

Standard software components 

 

Component Note 

SIMATIC PCS 7 V8.2 Part of SIMATIC PCS 7 ES/OS IPC847D W7 

S7 PLCSIM  Not part of SIMATIC PCS 7; appropriate licenses are 
required. 

APL Library V8.2 Part of SIMATIC PCS 7 V8.2 

SIMATIC BATCH V8.2 Not part of PCS 7; appropriate licenses are required. 

BRAUMAT Library V7.1 
Upd2 

Not part of PCS 7; appropriate licenses are required. 

PCS 7 Logic Matrix  
ES package 

 PCS 7 Logic Matrix 
Editor 

 PCS 7 Logic Matrix 
Library 

Not part of SIMATIC PCS 7 V8.2 

PCS 7 Logic Matrix  
OS package 

 PCS 7 Logic Matrix 
Viewer 

Not part of SIMATIC PCS 7 V8.2 

Example files and projects  

The following list contains all the files and projects used in this example. 
 

Component Note 

78463886_PROJ_CIP_PCS7_V82.zip PCS 7 V8.2 example project and 
SIMATIC BATCH Backup 

78463886_DOCU_CIP_de.pdf This document 
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3 Basics 

3.1 Process engineering 

Cleaning in Place (CIP) 

The term "Cleaning in Place", or CIP for short, designates a process which is used 
in the process industry for cleaning plant parts. The advantage of the process is 
that the cleaning takes place directly on the plant part in situ, without it having to be 
dismantled. 

A separate plant section is added to the plant for the CIP process. The cleaning fluid 
is prepared and stored here. The plant sections to be cleaned are designed so that 
they can be connected to the CIP plant section. The CIP plant section is positioned 
so that the paths to the plant sections to be cleaned are as short as possible. 

 

3.2 Automation technology 

The "unit" concept 

In this application example, the "CIP" plant section can be regarded as a unit. 

The term "unit" means a unit in process-related plants (plant section, apparatus, 
machines) including the sensors, actuators and the assigned automation software 
that is frequently required in this configuration of components. The unit as a "Type" 
is used as a template for generating many different programmable instances. 

ISA-88 

The application example is configured in accordance with the ISA-S88 standard. 
The standard describes a process with reference to the equipment available 
(physical model), the defined technical process (process model) and the equipment 
that is used to produce a batch (procedural control model). 
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The figure below describes the structure of the ISA-S88 standard. 
 

 

 

Note You will find detailed information on ISA-S88.01 in the manual entitled "PCS 7 
SIMATIC BATCH V8.2 Process Control System", in the chapter entitled 
"Technological basics complying with ISA-88.01". You will find this manual at the 
following link: https://support.industry.siemens.com/cs/de/en/view/109485956 

https://support.industry.siemens.com/cs/de/de/view/109485956
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4 Structure and Principle of Operation 

4.1 Project structure 

4.1.1 CFC chart naming convention 

A uniform naming convention has been used for identifying the process tag types - 
the function is named according to the European standard EN 62424. 
The following figure shows the composition of a process tag name: 
 

Fig. 4-1 

TIC_Detergent

Funktion

T = Temperatur(Erstbuchstabe)

I = Anzeige (Folgebuchstabe)

C = Regelung (Folgebuchstabe)

Bezeichnung

 
 

The following table contains the letters used in the application and their meanings: 

 

First letter Meaning 

F Flow 

L Level 

N Motor 

P Pressure 

Q Master value 

S Speed (velocity, rotational speed, frequency) 

T Temperature 

X Freely selectable first letter 

Y Control valve 

 

Subsequent letter Meaning 

C Control 

F Fraction 

I Indication 

S Switching (binary control function or switching function 

non-safety-related) 

T Monitoring (transmitter, analog value processing) 

H High (top) 

L Low (bottom) 
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4.1.2 Technological view 

The plant hierarchy of the Application Example “CIP" is configured in accordance 
with ISA S88.01. 

AS Project 

In the AS project, "CIP_AS", the first plant hierarchy level, "PRODUCTION", is 
defined as the plant and contains the neutral hierarchy folders. 

 "CIP" contains the "CIP" hierarchy folder, defined as a plant section 

 "MIXER PLANT" contains the "MIXER" hierarchy folder, defined as a plant section 

 "RECIPE CONTROL" contains no other objects 

 “Simulation” contains the simulation plans for our application example 

The "CIP" plant section contains the "UNIT_CIP" CFC diagram with the 
"UNIT_PLC" block, the hierarchy folders for the "CIP_SUPPLY" and 
"CIP_RETURN" equipment modules and the neutral hierarchy folders for the tanks 
in the CIP system. The necessary process tags are located in these folders. 

The "MIXER" plant section contains the "UNIT_MIXER" CFC diagram with the 
"UNIT_MIXER" "UNIT_PLC" block and the hierarchy folders for the "TANK_IN" and 
"TANK_OUT" equipment modules. The necessary process tags are located in 
these folders. 

 

Note The simulation plans are intended to illustrate the application example and are 
not further explained. 
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The following figures show the structure of the AS project: 
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CFC
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CFC

YS_RetPre 

Rinse

CFC

YS_Drain

CFC

CIP

CFC

CIP_Supply NC_Supply

CFC

YS_SupPre 

Rinse

CFC

NC_Supply

CFC

YS_SupPost 

Rinse

CFC

CIP SUPPLY

DERTERGENT TANK

CFC

DETEGENT LSH_Detergent

CFC

LSL_Detergent

CFC

NS_Detergent

CFC

NS_DetHeat

CFC

LIT_Detergernt

CFC

PUPA_Det

CFC

QIT_Detergent

CFC

TIC_DetHeatt

CFC

TIT_Detergent

CFC

TIT_DetHeat

CFC

YS_DetFresh 

Water

CFC

CFC

LSH_PostRinse

POST RINSE TANK

CFC

LSH_PretRinse

PRE RINSE TANK

YC_DetHeat

CFC

 

 

AS - Projekt

TANK_IN

CFC

LSH_Mixer

PRODUCTION

UNIT_MIXER

CFC

TANK_IN

CFC

YS_TankInDrain

CFC
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CFC

PUPA_Mixer

CFC

MIX PLANT
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OS project 

The plant hierarchy in the OS project is derived from the technological hierarchy of the 
AS project. The “CIP", "MIX PLANT" and "RECIPE CONTROL" neutral hierarchy 
folders contain the "OVERVIEW_CIP.pdl", "OVERVIEW_MIXPLANT.pdl" and 
"SIMATIC_BATCHOS.pdl" overview images. The sub-folders contain no other objects. 
 

OS- ProjektPRODUCTION

CIP

OVERVIEW_CIP

PDL

MIX PLANT

OVERVIEW_MIXPLANT

PDL

RECIPE CONTROL

SIMATIC_BATCHOS

PDL

 

4.2 Technical functions and process tags 

The "CIP" application example is composed of various technical functions and 
process tags. In a PCS 7 project, all the process tags, including the CMT, are 
based on the master data library. SFC types, which are also included in the master 
data library, are used to describe the technical functions. 

In the following chapters you will find information on the structure of the individual 
technical functions. You will also find a description of the SFCs used. 

4.2.1 CIP SUPPLY 

The detergent is fed from the tanks to the individual sections of the plant via the 
CIP supply. Which detergent is used is implemented by means of an SFC type 
instance. The fluid is taken from the appropriate tank, depending on which control 
strategy is selected. The quantities taken are defined by cleaning recipes in 
SIMATIC BATCH. The cleaning is carried out using cleaning batches and thus is 
also logged. 
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Setup 

The figure below shows the design of the supply apparatus: 
 

CIP Supply

 

 

The valves in the supply are opened and closed and the pump is started by an 
instance of the “CIP_SUPPLY" SFC type. 

The following table provides an overview of the elements and control module types 
used. 

 

Designation Technical function/ 
CMT 

Description 

CIP_Supply “CIP_SUPPLY” SFC type  Opening and closing the valves 
according to the specified control 
strategy 

 Starting and stopping the pump 

NC_Supply “MotVsd” Process tag for pump drive 

YS_SupDetergent  “Val” Process tag, detergent tank valve 

YS_SupPostRinse  “Val” Process tag, pre-rinse tank valve 

YS_SupPreRinse  “Val” Process tag, post-rinse tank valve 
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Process tag interconnection 

The following figure shows schematically the supply apparatus including the 
connections or SFC accesses that span the CFC diagram. 
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Parameter assignment 

The parameter assignment for the individual process tags is described in the 
following. A detailed description of the SFC type can be found in Chapter 4.4, 
"Sequences". 

NC_Supply 

The pump that is activated by the "NC_Supply" process tag regulates the cleaning 
fluid flow rate. In the Application Example, the control of the process tag is via the 
“CIP_Supply” SFC type instance. Process tag "NC_Supply" is an instance of the 
“MotVsd” control module type with the following selected variants: 

 Intlock 

 Permit 

 Rbk 

 SP_Out 

 

The following table shows the interconnections to other process tags and parameters: 
 

Block Connection Value Use 

FbkFwd SimOn 1 Simulated process value active 

SimPV_In  Interconnection to simulated process 
value (SimNC_Supply\SimFbkFwd.Out) 

Rbk SimOn 1 Simulated process value active 

SimPV_In  Interconnection to simulated process 
value (SimNC_Supply\SimSpeed.Out) 

Fwd SimOn 1 Simulated process value active 

SimPV_In  Interconnection to simulated process 
value (NC_Supply\U.Fwd) 

SP_Out SimOn 1 Simulated process value active 

SimPV_In  Interconnection to simulated process 
value (NC_Supply\U.SP_Out) 

Calc_SP_Ext In1 1 Setpoint in [m³/h] 
(interconnection to the SFC) 

In2 1.666667 Conversion factor 

Out  Interconnection to the SP_Ext  
(NC_Supply\U.SP_Ext) 
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Block Connection Value Use 

U 

 

FwdAut  Activation order for forward operation in 
automatic mode 
(CIP_Supply\CIP_SUPPLY.M1_FwdAut) 

Occupied  Occupied by batch 
(CIP_Supply\CIP_SUPPLY.QOCCUPIE) 

StepNo  Batch step number 
(CIP_Supply\CIP_SUPPLY.QSTEP_NO) 

BatchName  Batch name 
(CIP_Supply\CIP_SUPPLY.QBA_NA) 

BatchID  Batch Identification 
(CIP_Supply\CIP_SUPPLY.QBA_ID) 

BatchEn  Batch occupancy release 
(CIP_Supply\CIP_SUPPLY.QBA_EN) 

Intlock In01  Interlocking of motor (Interconnection for 
Interlock logic LM_CIP\E004.Out) 

 

Note When “U.FwdAut” and “CIP_SUPPLY.M1_FwdAut” are interconnected, all other 
interconnections between the motor module and the SFC type instances are also 
created. These are not listed in the above table. 

 

The “Intlock” block is used to interlock the motor. This ensures that the motor only 
runs if one of the valves is open as well. The interlocking logic is generated with the 
PCS 7 Logic Matrix. See Chapter 4.3 “Interlocks" for a detailed description of the 
interlock logics. 

YS_SupDetergent 

The valve that is activated by the “YS_SupDetergent” process tag controls the 
discharge from the detergent tank to the supply. In the Application Example, the 
control of the process tag is via the “CIP_Supply” SFC type instance. Process tag 
"YS_SupDetergent" is an instance of the “Val” control module type with the 
following selected variants: 

 FbkClose 

 FbkOpen 

 Permit 

 Opt_1Ctrl 
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The following table shows the interconnections to other process tags and parameters: 
 

Block Connection Value Use 

FbkOpen SimOn 1 Simulated process value active 

SimPV_In  Interconnection to simulated process value 
(SimYS_SupDetergent\SimFbkOpen.Out) 

FbkClose SimOn 1 Simulated process value active 

SimPV_In  Interconnection to simulated process value 
(SimYS_SupDetergent\SimFbkOpen.InvOut) 

Ctrl SimOn 1 Simulated process value active 

SimPV_In  Interconnection to simulated process value 
(SimYS_SupDetergent\V.Ctrl) 

V 

 

OpenAut  Activation order for opening in automatic 
mode 
(CIP_Supply\CIP_SUPPLY.V2_OpenAut) 

Occupied  Occupied by batch 
(CIP_Supply\CIP_SUPPLY.QOCCUPIE) 

StepNo  Batch step number 
(CIP_Supply\CIP_SUPPLY.QSTEP_NO) 

BatchName  Batch name 
(CIP_Supply\CIP_SUPPLY.QBA_NA) 

BatchID  Batch Identification 
(CIP_Supply\CIP_SUPPLY.QBA_ID) 

BatchEn  Batch occupancy release 
(CIP_Supply\CIP_SUPPLY.QBA_EN) 

 

Note When “V.OpenAut” and “CIP_SUPPLY.V2_OpenAut” are interconnected, all 
other interconnections between the valve module and the SFC type instances 
are also created. These are not listed in the above table. 

 

YS_SupPostRinse 

The valve that is activated by the “YS_SupPostRinse” process tag controls the 
discharge from the post-rinse tank to the supply. In the Application Example, the 
control of the process tag is via the “CIP_Supply” SFC type instance. Process tag 
"YS_SupPostRinse" is an instance of the “Val” control module type with the 
following selected variants: 

 FbkClose 

 FbkOpen 

 Permit 

 Opt_1Ctrl 
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The following table shows the interconnections to other process tags and parameters: 
 

Block Connection Value Use 

FbkOpen SimOn 1 Simulated process value active 

SimPV_In  Interconnection to simulated process value 
(SimYS_SupPostRinse\SimFbkOpen.Out) 

FbkClose SimOn 1 Simulated process value active 

SimPV_In  Interconnection to simulated process value 
(SimYS_SupPostRinse\SimFbkClose.InvOut) 

Ctrl SimOn 1 Simulated process value active 

SimPV_In  Interconnection to simulated process value 
(SimYS_SupPostRinse\V.Ctrl) 

V 

 

OpenAut  Activation order for opening in automatic 
mode 
(CIP_Supply\CIP_SUPPLY.V3_OpenAut) 

Occupied  Occupied by batch 
(CIP_Supply\CIP_SUPPLY.QOCCUPIE) 

StepNo  Batch step number 
(CIP_Supply\CIP_SUPPLY.QSTEP_NO) 

BatchName  Batch name 
(CIP_Supply\CIP_SUPPLY.QBA_NA) 

BatchID  Batch Identification 
(CIP_Supply\CIP_SUPPLY.QBA_ID) 

BatchEn  Batch occupancy release 
(CIP_Supply\CIP_SUPPLY.QBA_EN) 

 

 

Note When “V.OpenAut” and “CIP_SUPPLY.V3_OpenAut” are interconnected, all 
other interconnections between the valve module and the SFC type instances 
are also created automatically. These are not listed in the above table. 

 

YS_SupPreRinse 

The valve that is activated by the “YS_SupPreRinse” process tag controls the 
discharge from the pre-rinse tank to the supply. In the Application Example, the 
control of the process tag is via the “CIP_Supply” SFC type instance. Process tag 
“YS_SupPreRinse" is an instance of the “Val” control module type with the 
following selected variants: 

 FbkClose 

 FbkOpen 

 Permit 

 Opt_1Ctrl 
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The following table shows the interconnections to other process tags and parameters: 
 

Block Connection Value Use 

FbkOpen SimOn 1 Simulated process value active 

SimPV_In  Interconnection to simulated process value 
(SimYS_SupPreRinse\SimFbkOpen.Out) 

FbkClose SimOn 1 Simulated process value active 

SimPV_In  Interconnection to simulated process value 
(SimYS_SupPreRinse\SimFbkClose.InvOut) 

Ctrl SimOn 1 Simulated process value active 

SimPV_In  Interconnection to simulated process value 
(YS_SupPreRinse\V.Ctrl) 

V 

 

OpenAut  Activation order for opening in automatic 
mode 
(CIP_Supply\CIP_SUPPLY.V3_OpenAut) 

Occupied  Occupied by batch 
(CIP_Supply\CIP_SUPPLY.QOCCUPIE) 

StepNo  Batch step number 
(CIP_Supply\CIP_SUPPLY.QSTEP_NO) 

BatchName  Batch name 
(CIP_Supply\CIP_SUPPLY.QBA_NA) 

BatchID  Batch Identification 
(CIP_Supply\CIP_SUPPLY.QBA_ID) 

BatchEn  Batch occupancy release 
(CIP_Supply\CIP_SUPPLY.QBA_EN) 

 

 

Note When “V.OpenAut” and “CIP_SUPPLY.V1_OpenAut” are interconnected, all 
other interconnections between the valve module and the SFC type instances 
are also created automatically. These are not listed in the above table. 
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4.2.2 CIP RETURN 

The temperature and concentration of the fluid are determined in the return line 
and, depending on the measured values, it is fed back into the CIP tanks. The 
valves to the tanks are opened depending on the quality of the fluid. The fluid from 
the pre-rinse phase is fed directly into the drain. If the tanks are full or if the quality 
is not adequate, the fluid is also discharged into the drain. 

Setup 

The figure below shows the design of the supply apparatus: 
 

CIP Return

 

 

The valves in the return are opened and closed by an instance of the 
"CIP_RETURN" SFC type. 
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The following table provides an overview of the elements and control module types 
used. 
 

Designation Technical function/ 
CMT 

Description 

CIP_Return SFC type “CIP_RETURN”  Opening and closing the 
valves according to the 
specified control strategy 

 Interface for connecting to 
SIMATIC BATCH 

YS_RetDetergent  “Val” Process tag Valve, detergent 
tank return line 

YS_RetDrain  “Val” Process tag return valve drain 

YS_RetPreRinse  “Val” Process tag valve post-rinse tank 
return 

QIT_Return AMon Acquisition of detergent 
concentration in the CIP return 
line 

TIT_Return AMon Determining the fluid 
temperature in the return line 
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Process tag interconnection 

The following figure shows schematically the supply apparatus including the 
connections or SFC accesses that span the CFC diagram. 
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Parameter assignment 

The parameter assignment for the individual process tags is described in the 
following. A detailed description of the SFC type can be found in Chapter 4.4, 
"Sequences". 

YS_RetDetergent 

The valve that is activated by the “YS_RetDetergent” process tag controls the 
supply to the detergent tank in the return line. In the Application Example, the 
control of the process tag is via the “CIP_Return” SFC type instance. Process tag 
“YS_RetDetergent" is an instance of the “Val” control module type with the 
following selected variants: 

 FbkClose 

 FbkOpen 

 Permit 

 Opt_1Ctrl 

 Intlock 

 

The following table shows the interconnections to other process tags and parameters: 
 

Block Connection Value Use 

FbkOpen SimOn 1 Simulated process value active 

SimPV_In  Interconnection to simulated process value 
(SimYS_RetDetergent\SimFbkOpen.Out) 

FbkClose SimOn 1 Simulated process value active 

SimPV_In  Interconnection to simulated process value 
(SimYS_RetDetergent\SimFbkClose.InvOut) 

Ctrl SimOn 1 Simulated process value active 

SimPV_In  Interconnection to simulated process value 
(YS_RetDetergent\V.Ctrl) 

V OpenAut  Activation order for opening in automatic 
mode 
(CIP_Return\CIP_RETURN.V2_OpenAut) 

Occupied  Occupied by batch 
(CIP_Return\CIP_RETURN.QOCCUPIE) 

StepNo  Batch step number 
(CIP_Return\CIP_RETURN.QSTEP_NO) 

BatchName  Batch name 
(CIP_Return\CIP_RETURN.QBA_NA) 

BatchID  Batch Identification 
(CIP_Return\CIP_RETURN.QBA_ID) 

BatchEn  Batch occupancy release 
(CIP_Supply\CIP_SUPPLY.QBA_EN) 

Intlock In01  Interlocking of valve (Interconnection for 
Interlock logic LM_CIP\E001.Out) 
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Note When “V.OpenAut” and “CIP_SUPPLY.V2_OpenAut” are interconnected, all 
other interconnections between the valve module and the SFC type instances 
are also created automatically. These are not listed in the above table. 

 

The “Intlock” block is used to interlock the valve. This ensures that it is only opened 
if the detergent tank is not full. The interlocking logic is generated with the PCS 7 
Logic Matrix. See Chapter 4.3 “Interlocks" for a detailed description of the interlock 
logics. 

YS_RetDrain 

The valve that is activated by the “YS_RetDrain” process tag controls the supply to 
the drain in the return line. In the Application Example, the control of the process 
tag is via the “CIP_Return” SFC type instance. Process tag "YS_RetDrain" is an 
instance of the “Val” control module type with the following selected variants: 

 FbkClose 

 FbkOpen 

 Permit 

 Opt_1Ctrl 

 

The following table shows the interconnections to other process tags and parameters: 
 

Block Connection Value Use 

FbkOpen SimOn 1 Simulated process value active 

SimPV_In  Interconnection to simulated process 
value 
(SimYS_RetDrain\SimFbkOpen.Out) 

FbkClose SimOn 1 Simulated process value active 

SimPV_In  Interconnection to simulated process 
value 
(SimYS_RetDrain\SimFbkClose.InvOut) 

Ctrl SimOn 1 Simulated process value active 

SimPV_In  Interconnection to simulated process 
value (YS_RetDrain\V.Ctrl) 

V OpenAut  Activation order for opening in automatic 
mode 
(CIP_Return\CIP_RETURN.V3_OpenAut) 

Occupied  Occupied by batch 
(CIP_Return\CIP_RETURN.QOCCUPIE) 

StepNo  Batch step number 
(CIP_Return\CIP_RETURN.QSTEP_NO) 

BatchName  Batch name 
(CIP_Return\CIP_RETURN.QBA_NA) 

BatchID  Batch Identification 
(CIP_Return\CIP_RETURN.QBA_ID) 

BatchEn  Batch occupancy release 
(CIP_Supply\CIP_SUPPLY.QBA_EN) 
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Note When “V.OpenAut” and “CIP_RETURN.V3_OpenAut” are interconnected, all 
other interconnections between the valve module and the SFC type instances 
are also created automatically. These are not listed in the above table. 

YS_RetPreRinse 

The valve that is activated by the “YS_RetPreRinse” process tag controls the 
supply to the detergent tank in the return line. In the Application Example, the 
control of the process tag is via the “CIP_Return” SFC type instance. Process tag 
"YS_RetPreRinse" is an instance of the “Val” control module type with the following 
selected variants: 

 FbkClose 

 FbkOpen 

 Permit 

 Opt_1Ctrl 

 Intlock 

 

The following table shows the interconnections to other process tags and parameters: 
 

Block Connection Value Use 

FbkOpen SimOn 1 Simulated process value active 

SimPV_In  Interconnection to simulated process value 
(SimYS_RetPreRinse\SimFbkOpen.Out) 

FbkClose SimOn 1 Simulated process value active 

SimPV_In  Interconnection to simulated process value 
(SimYS_RetPreRinse\SimFbkClose.InvOut) 

Ctrl SimOn 1 Simulated process value active 

SimPV_In  Interconnection to simulated process value 
(YS_RetPreRinse\V.Ctrl) 

V OpenAut  Activation order for opening in automatic 
mode 
(CIP_Return\CIP_RETURN.V1_OpenAut) 

Occupied  Occupied by batch 
(CIP_Return\CIP_RETURN.QOCCUPIE) 

StepNo  Batch step number 
(CIP_Return\CIP_RETURN.QSTEP_NO) 

BatchName  Batch name 
(CIP_Return\CIP_RETURN.QBA_NA) 

BatchID  Batch Identification 
(CIP_Return\CIP_RETURN.QBA_ID) 

BatchEn  Batch occupancy release 
(CIP_Supply\CIP_SUPPLY.QBA_EN) 

Intlock In01  Interlocking of valve (Interconnection for 
Interlock logic LM_CIP\E002.Out) 

 

Note When “V.OpenAut” and “CIP_RETURN.V1_OpenAut” are interconnected, all 
other interconnections between the valve module and the SFC type instances 
are also created automatically. These are not listed in the above table. 
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The “Intlock” block is used to interlock the valve. This ensures that it is only opened 
if the detergent tank is not full. The interlocking logic is generated with the PCS 7 
Logic Matrix. See Chapter 4.3 “Interlocks" for a detailed description of the interlock 
logics. 

QIT_Return 

The display process tag "QIT_Return" is used for detecting and displaying the 
detergent concentration. Process tag "QIT_Return" is an instance of the “AMon” 
control module type with the following selected variants: 

 Opt_PV_Scale 

 PV_In 

 

The following table shows the interconnections to other process tags and parameters: 
 

Block Connection Value Use 

PV_Scale HiScale 150 Scaling of the process value 

PV_Unit IN 1289 Process value unit (mS) 

PV_In SimOn 1 Simulated process value active 

SimPV_In  Interconnection to simulated process value 
(conductance\ConducReturn.Out) 

I Occupied  Occupied by batch 
(CIP_Return\CIP_RETURN.QOCCUPIE) 

StepNo  Batch step number 
(CIP_Return\CIP_RETURN.QSTEP_NO) 

BatchName  Batch name 
(CIP_Return\CIP_RETURN.QBA_NA) 

BatchID  Batch Identification 
(CIP_Return\CIP_RETURN.QBA_ID) 

PV_Out  Process value 
(CIP_Return\CIP_RETURN.DET_CONC_AI; 
CIP_Return\CIP_RETURN.PRE_CONC_AI) 

TIT_Return 

The display process tag “TIT_Return" is used for detecting and displaying the fluid 
temperature. Process tag “TIT_Return" is an instance of the “AMon” control module 
type with the following selected variants: 

 Opt_PV_Scale 

 PV_In 
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The following table shows the interconnections to other process tags and parameters: 
 

Block Connection Value Use 

PV_Unit IN 1001 Process value unit (ºC) 

PV_In SimOn 1 Simulated process value active 

SimPV_In  Interconnection to simulated process value 
(Temperature\TemInCRet.Out) 

I Occupied  Occupied by batch 
(CIP_Return\CIP_RETURN.QOCCUPIE) 

StepNo  Batch step number 
(CIP_Return\CIP_RETURN.QSTEP_NO) 

BatchName  Batch name 
(CIP_Return\CIP_RETURN.QBA_NA) 

BatchID  Batch Identification 
(CIP_Return\CIP_RETURN.QBA_ID) 

PV_Out  Process value 
(CIP_Return\CIP_RETURN.DET_TMP_AI; 
CIP_Return\CIP_RETURN.PRE_TMP_AI) 
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4.2.3 Detergent tank 

The detergent tank contains the detergent used for cleaning. The detergent is 
heated to the required temperature in the tank. The required detergent 
concentration is also set. The detergent tank is continuously filled, either from the 
return line during the cleaning phases or by supplying fresh water and alkali. The 
temperature of the fluid in the tank is continuously regulated to a specified value. 

Setup 

The figure below shows the design of the detergent tank: 
 

Detergent Tank

 

 

The tank contains three level sensors which detect the maximum, minimum and 
current fill levels, respectively. The fluid is pumped via pipes through a heat 
exchanger in order to control the temperature. The concentration of the alkali is also 
measured in the pipes. The circulation of the fluid is controlled by means of an 
instance of the “DETERGENT” SFC type. This is also used to control the 
concentration and to pass the setpoints for the PID controller for temperature control. 
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The following table provides you with an overview of the elements and control 
module types used. 
 

Designation Technical function/ 
CMT 

Description 

Detergent SFC type “FILL_HEAT_CONC” Setting of detergent 
characteristics depending on the 
setpoints of the control strategy 

LIT_Detergent AMon Acquisition of fill level in 
detergent tank 

LSH_Detergent DMon Acquisition of maximum fill level 
in detergent tank reached 

LSL_Detergent DMon Acquisition of minimum fill level 
in detergent tank reached 

NS_DetCon Mot Process tag for pump drive for 
addition of alkali 

NS_DetHeat Mot Process tag for pump drive for 
heating circuit 

PuPaDet  Process tag for metering the 
addition of alkali 

QIT_Detergent AMon Acquisition of detergent 
concentration in CIP detergent 
tank 

TIC_Heat Ctrl Process tag for the control of the 
fluid temperature in the heating 
circuit 

TIT_Detergent AMon Determining the fluid 
temperature in detergent tank 

TIT_DetHeat AMon Determining the fluid 
temperature in heating circuit 

YC_DetHeat ValAn Process tag for control valve in 
heating circuit 

YS_DetFreshWater Val Valve for fresh water supply to 
detergent tank process tag 
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Parameter assignment 

The parameter assignment for the individual process tags is described in the 
following. A detailed description of the SFC type can be found in Chapter “4.3. 
Sequences". 

LIT_Detergent 

The display process tag "LIT_Detergent" is used for detecting and displaying the fill 
level in the detergent tank. Process tag “LIT_Return" is an instance of the “AMon” 
control module type with the following selected variants: 

 Opt_PV_Scale 

 PV_In 

 

The following table shows the interconnections to other process tags and parameters: 
 

Block Connection Value Use 

PV_Scale HiScale 25000 Scaling of the process value 

PV_Unit IN 1038 Process value unit (L) 

PV_In SimOn 1 Simulated process value active 

SimPV_In  Interconnection to simulated process 
value 
(Sim_Level_DetergentTank\Level.Out) 

I PV_Out  Process value 
(Detergent\DETERGENT.LEVEL_AI; 
LM_CIP\C001.Ana1) 

 

LSH_Detergent 

The display process tag “LSH_Detergent" is used for detecting and displaying the 
maximum fill level of the detergent tank. The "LSH_Detergent" process tag is an 
instance of the "DMon" CMT with “In” variant selected. 

The following table shows the interconnections to other process tags and parameters: 
 

Block Connection Value Use 

In SimOn 1 Simulated process value active 

SimPV_In  Interconnection to simulated process 
value 
(Sim_Level_DetergentTank\LSH.GE) 

S Out  Digital output value 
(CIP_Return\CIP_RETURN.LS1Out; 
LM_CIP\C001.Dig1) 
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LSL_Detergent 

The display process tag "LSL_Detergent" is used for detecting and displaying the 
minimum fill level of the detergent tank. Process tag “LSL_Detergent" is an 
instance of the "DMon" CMT with “In” variant selected. 

The following table shows the interconnections to other process tags and parameters: 
 

Block Connection Value Use 

In SimOn 1 Simulated process value active 

SimPV_In  Interconnection to simulated process 
value 
(Sim_Level_DetergentTank\LSL.LE) 

 

NS_DetCon 

The pump that is activated by the “NC_DetCon" process tag regulates the metering 
of the addition of detergent. In the Application Example, the control of the process 
tag is via the “DETERGENT” SFC type instance and the “PuPa_Det” process tag. 
Process tag "NS_DetCon" is an instance of the “Mot” control module type with the 
following selected variants: 

 Permit 

 Opt_1Fbk 

 Start 

The process tag has been expanded to incorporate the following functions: 

 Or04 – “Start_NSDetCon” 

 Or04 – “Stop_NSDetCon” 

 

The following table shows the interconnections to other process tags and parameters: 
 

Block Connection Value Use 

Fbk SimOn 1 Simulated process value active 

SimPV_In  Interconnection to simulated process 
value (Sim_NSDetCon\SimFbkRun.Out) 

Start SimOn 1 Simulated process value active 

SimPV_In  Interconnection to simulated process 
value (NSDetCon\U.Start) 

Start_NSDetCon In1  Start pulse 
(PuPa_Det\Strengh.ActGrp01) 

In2  Start pulse 
(Detergent\DETERGENT.M2_AutStart) 

Out  Start pulse 
(NS_DetCon\U.StartAut) 
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Block Connection Value Use 

Stop_NSDetCon In1  Stop pulse 
(PuPa_Det\Strengh.ActGrp01 inverted) 

In2  Start pulse 
(Detergent\DETERGENT.M2_AutStop) 

Out  Stop pulse 
(NS_DetCon\U.StopAut) 

U ModLiop  Switchover of operating mode selection 
manual/switchover 
(Detergent\DETERGENT.M2_ModLiOp) 

 

Note When “U.ModLiOp” and “DETERGENT.M2_ModLiOP” are interconnected, all 
other interconnections between the motor module and the SFC type instances 
are also created automatically. These are not listed in the above table. 

 

NS_DetHeat 

The pump activated by the “NS_DetHeat” process tag controls the circulation of 
alkali through the heating circuit. In the Application Example, the control of the 
process tag is via the “DETERGENT” SFC type instance. Process tag 
"NS_DetHeat" is an instance of the “Mot” control module type with the following 
selected variants: 

 Permit 

 Opt_1Fbk 

 Start 

 

The following table shows the interconnections to other process tags and parameters: 
 

Block Connection Value Use 

Fbk SimOn 1 Simulated process value active 

SimPV_In  Interconnection to simulated process 
value (Sim_NSDetCon\SimFbkRun.Out) 

Start SimOn 1 Simulated process value active 

SimPV_In  Interconnection to simulated process 
value (NSDetHeat\U.Start) 

U StartAut  Activation order for starting in automatic 
mode 
(Detergent\DETERGENT.M1_StartAut) 

 

Note When “U.ModLiOp” and “DETERGENT.M2_ModLiOP” are interconnected, all 
other interconnections between the motor module and the SFC type instances 
are also created automatically. These are not listed in the above table. 
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PuPaDet 

The “PuPaDet” process tag serves for the pulsed activation of the metering pump 
for detergent concentration. In the Application Example, the control of the process 
tag is via the “DETERGENT” SFC type instance. The “PuPa_Det" process tag 
forwards the pulsed control command on to the "NS_DetCon" process tag. 

The following table shows the interconnections to other process tags and parameters: 

 

Block Connection Value Use 

BlPuPa   Inserted as "STRENGTH" for pulse/pause 
function 

STRENGH ModLiOp  Switchover of operating mode selection 
manual/switchover 
(Detergent\DETERGENT.PuPa1_ModLiOp) 

 

Note When “STRENGH.ModLiOp” and “DETERGENT.PuPa1_ModLiOp” are 
interconnected, all other interconnections between the pulse/pause module and 
the SFC type instances are also created automatically. These are not listed in 
the above table. 

 

QIT_Detergent 

The display process tag “QIT_Detergent" is used for detecting and displaying the 
detergent concentration in the detergent tank. Process tag “QIT_Detergent" is an 
instance of the “AMon” control module type with the following selected variants: 

 Opt_PV_Scale 

 PV_In 

 

The following table shows the interconnections to other process tags and parameters: 
 

Block Connection Value Use 

PV_Scale HiScale 180 Scaling of the process value 

PV_Unit IN 1289 Process value unit (mS) 

PV_In SimOn 1 Simulated process value active 

SimPV_In  Interconnection to simulated process 
value (conductance\ConducTank.Out) 

I PV_Out  Process value 
(Detergent\DETERGENT.CONC_AI) 
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TIC_DetHeat 

The temperature of the fluid in the detergent tank is determined in the 
"TIC_DetHeat" process tag. The current temperature of the fluid is registered in the 
“TIT_Detergent” display process tag and transferred to the "TIC_DetHeat” 
controller process tag. In the Application Example, the setpoint is specified by 
means of the "DETERGENT" SFC type instance. The “TIC_DetHeat” process tag 
passes the control variable to the "YC_DetHeat" control valve. “TIC_DetHeat” is an 
instance of the “Ctrl” CMT. 

The following table shows the interconnections to other process tags and parameters: 
 

Block Connection Value Use 

AIF_SFC SP_LiOp  Setpoint source internal/external via 
interconnection 
(Detergent\DETERGENT.PID1_SP_LiOp) 

C Gain 20.277 Controller gain 

TI 186.941 Controller adjustment time 

to_Actor_Slave Out  Interconnection for the valve (control) 
(YC_DetHeat\from_CTRL.In) 

from_Actor_Slave In  Interconnection for the valve (control) 
(YC_DetHeat\to_Ctrl.Out) 

 

Note When “AIF_SFC.SP_LiOp” and “DETERGENT.PID1_SP_LiOp” are 
interconnected, all other interconnections between the SFC interface module and 
the SFC type instances are also created automatically. These are not listed in 
the above table. 

 

TIT_Detergent 

The display process tag “TIT_Detergent" is used for detecting and displaying the 
fluid temperature in the detergent tank. Process tag “TIT_Detergent" is an instance 
of the “AMon” control module type with the following selected variants: 

 Opt_PV_Scale 

 PV_In 

 

The following table shows the interconnections to other process tags and parameters: 
 

Block Connection Value Use 

PV_Unit IN 1001 Process value unit (ºC) 

PV_In SimOn 1 Simulated process value active 

SimPV_In  Interconnection to simulated process value 
(Temperature\TemInC.Out) 

I PV_Out  Process value (Detergent\DETERGENT. 
TEMP_AI; TIC_DetHeat\C.PV) 
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TIT_DetHeat 

The display process tag “TIT_Detheat" is used for detecting and displaying the fluid 
temperature in the heating circuit. Process tag “TIT_Detheat" is an instance of the 
“AMon” control module type with the following selected variants: 

 Opt_PV_Scale 

 PV_In 

 

The following table shows the interconnections to other process tags and parameters: 
 

Block Connection Value Use 

PV_Unit IN 1001 Process value unit (ºC) 

PV_In SimOn 1 Simulated process value active 

SimPV_In  Interconnection to simulated process value 
(Temperature\TemTIT_DetHeat.Out) 

 

YC_DetHeat 

The valve that is activated by the “YC_DetHeat” process tag controls the flow rate of  
the heating medium in the heating circuit. In the Application Example, the control of the 
process tag is via the “DETERGENT” SFC type instance. The setpoint is specified via 
the "TIC_DetHeat” controller process tag. Process tag “YC_DetHeat" is an instance of 
the “ValAn” control module type with the following selected variants: 

 Ctrl 

 FbkClose 

 FbkOpen 

 MV_Out 

 Opt_If_Ctrl 

 Permit 

 Rbk 
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The following table shows the interconnections to other process tags and parameters: 
 

Block Connection Value Use 

FbkOpen SimOn 1 Simulated process value active 

SimPV_In  Interconnection to simulated process 
value 
(SimYC_Detheat\SimValveOpen.GE) 

FbkClose SimOn 1 Simulated process value active 

SimPV_In  Interconnection to simulated process 
value 
(SimYC_Detheat\SimValveClose.GE) 

Rbk SimOn 1 Simulated process value active 

SimPV_In  Interconnection to simulated process 
value (SimYC_Detheat\SimRbk.Out) 

Ctrl SimOn 1 Simulated process value active 

SimPV_In  Interconnection to simulated process 
value (YS_Detheat\V.Ctrl) 

MV_Out SimOn 1 Simulated process value active 

SimPV_In  Interconnection to simulated process 
value (YS_Detheat\V.MV) 

V OpenAut  Activation signal to open valve 
(Detergent\DETERGENT.V2_OpenAut 

from_Ctrl In  Interconnection to the controller 
(TIC_DetHeat\to_Actor_Slave.Out) 

to_Ctrl Out  Interconnection for the controller 
(TIC_DetHeat.from_Actor_Slave) 

 

 

Note When “V.OpenAut” and “DETERGENT.V2_OpenAut” are interconnected, all 
other interconnections between the valve module and the SFC type instances 
are also created automatically. These are not listed in the above table. 

 

YS_DetFreshWater 

The valve that is activated by the “YS_DetFreshwater” process tag controls the 
inlet of fresh water to the detergent tank. In the Application Example, the control of 
the process tag is via the “DETERGENT” SFC type instance. Process tag 
"YS_DetFreshWater" is an instance of the “Val” control module type with the 
following selected variants: 

 FbkClose 

 FbkOpen 

 Permit 

 Opt_1Ctrl 

 Intlock 
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The following table shows the interconnections to other process tags and parameters: 
 

Block Connection Value Use 

FbkOpen SimOn 1 Simulated process value active 

SimPV_In  Interconnection to simulated process value 
(SimYS_FreshWater\SimFbkOpen.Out) 

FbkClose SimOn 1 Simulated process value active 

SimPV_In  Interconnection to simulated process value 
(SimYS_FreshWater\SimFbkClose.InvOut) 

Ctrl SimOn 1 Simulated process value active 

SimPV_In  Interconnection to simulated process value 
(YS_DetFreshWater\V.Ctrl) 

V OpenAut  Activation order for opening in automatic 
mode 
(Detergent\DETERGENT.V1_OpenAut) 

Intlock In01  Interlocking of valve (Interconnection for 
Interlock logic LM_CIP\E001.Out) 

 

Note When “V.OpenAut” and “DETERGENT.V1_OpenAut” are interconnected, all 
other interconnections between the valve module and the SFC type instances 
are also created automatically. These are not listed in the above table. 

 

The “Intlock” block is used to interlock the valve. This ensures that it is only opened 
if the detergent tank is not full. The interlocking logic is generated with the PCS 7 
Logic Matrix. See Chapter 4.3 “Interlocks" for a detailed description of the interlock 
logics. 
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4.2.4 Post-rinse tank 

Fresh water for post-rinsing is stored in the post rinse tank. It is drawn off during 
the post-rinse phase. No water is fed into this tank from the return line. In the 
application example the water is not reprocessed and can be used at ambient 
temperature. Fluid can be drawn from the post-rinse tank at any time, provided the 
level does not fall below the minimum fill level. 

Setup 

The figure below shows the design of the post-rinse tank: 
 

Postrinse

Tank

 

 

The tank contains two level sensors which register the maximum and minimum fill 
levels. When the minimum fill level is reached the fresh water valve is opened. 
When the maximum fill level is reached the fresh water valve is closed. In the 
Application Example activation of the fresh water is via the PCS 7 Logic Matrix. 

 

Note The design of the post-rinse tank depends strongly on the requirements of the 
cleaning process. The detergent tank (process tags and "FILL_HEAT_CONC" 
SFC type) can be taken as a template for configuration. 
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The following table shows an overview of the elements and control module types used: 
 

Designation Technical function/ 
CMT 

Description 

YS_FreshWaterPostrinse  “Val” Process tag Fresh water valve of 
post-rinse tank 

LSH_Postrinse DMon Acquisition of maximum fill level 
in fresh water tank reached 

LSL_Postrinse DMon Acquisition of minimum fill level 
in fresh water tank reached 

 

Parameter assignment 

The parameter assignment for the individual process tags is described in the 
following. A detailed description of the fresh water valve activation can be found in 
Chapter 4.3, “Interlocks”. 

YS_FreshWaterPostrinse 

The valve that is activated by the “YS_FreshwaterPostrinse” process tag controls 
fresh water intake into the post-rinse tank. In the Application Example, the control 
of the process tag is effected via the “LM_CIP” CFC generated by the PCS 7 Logic 
Matrix. Process tag "YS_FreshWaterPostrinse" is an instance of the “Val” control 
module type with the following selected variants: 

 FbkClose 

 FbkOpen 

 Permit 

 Opt_1Ctrl 

 Intlock 

 

The following table shows the interconnections to other process tags and parameters: 
 

Block Connection Value Use 

FbkOpen SimOn 1 Simulated process value active 

SimPV_In  Interconnection to simulated process value 
(SimYS_FreshWaterPostR\SimFbkOpen.Out) 

FbkClose SimOn 1 Simulated process value active 

SimPV_In  Interconnection to simulated process value 
(SimYS_FreshWaterPostR\SimFbkClose.InvOut) 

Ctrl SimOn 1 Simulated process value active 

SimPV_In  Interconnection to simulated process value 
(YS_FreshWaterPostrinse\V.Ctrl) 

V OpenAut  Activation order for opening in automatic mode 
(LM_CIP\E005.Out) 

Intlock In01  Interlocking of valve (Interconnection for 
Interlock logic LM_CIP\E003.Out) 
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The “Intlock” block is used to interlock the valve. This ensures that it is only opened if 
the post-rinse tank is not full. The interlocking logic is generated with the PCS 7 Logic 
Matrix. See Chapter 4.3 “Interlocks" for a detailed description of the interlock logics. 

 

LSH_Postrinse 

The “LSH_Postrinse" display process tag is used for detecting and displaying the 
maximum fill level of the post-rinse tank. Process tag “LSL_Postrinse" is an 
instance of the "DMon" CMT with “In” variant selected. 

The following table shows the interconnections to other process tags and parameters: 
 

Block Connection Value Use 

In SimOn 1 Simulated process value active 

SimPV_In  Interconnection to simulated process 
value 
(Sim_Level_PostRTank\LSH.GE) 

S Out  Digital output value 
(LM_CIP\C003.Dig1) 

 

LSL_Postrinse 

The display process tag “LSL_Postrinse" is used for detecting and displaying the 
minimum fill level of the post-rinse tank. Process tag “LSL_Postrinse" is an 
instance of the "DMon" CMT with “In” variant selected. 

The following table shows the interconnections to other process tags and parameters: 
 

Block Connection Value Use 

In SimOn 1 Simulated process value active 

SimPV_In  Interconnection to simulated process 
value 
(Sim_Level_PostRTank\LSL.LE) 

S Out  Digital output value 
(LM_CIP\C005.Dig1) 
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4.2.5 Pre-rinse tank 

The pre-rinse tank contains the detergent used for pre-rinse phase. In the 
application example the pre-rinse tank is filled through the return during the 
cleaning phase. The temperature and the detergent concentration of the liquid in 
the tank are not controlled in the application example. 

Setup 

The figure below shows the design of the pre rinse tank: 
 

Postrinse

Tank

 

 

The tank contains two level sensors which register the maximum and minimum fill 
levels. Acquisition of the minimum fill level only serves the purpose of visualization 
in this application example. When the maximum fill level is reached the valve in the 
return line is closed and locked. 

 

Note The design of the pre-rinse tank depends strongly on the requirements of the 
cleaning process. The detergent tank (process tags and "FILL_HEAT_CONC" 
SFC type) can be taken as a template for configuration. 
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The following table provides you with an overview of the elements and control 
module types used: 
 

Designation Technical function/ 
CMT 

Description 

LSH_Postrinse DMon Acquisition of maximum fill level 
in fresh water tank reached 

LSL_Postrinse DMon Acquisition of minimum fill level 
in fresh water tank reached 

 

Parameter assignment 

The parameter assignment for the individual process tags is described in the 
following. A detailed description of the fresh water valve activation can be found in 
Chapter 4.3, “Interlocks”. 

LSH_PreRinse 

The display process tag “LSH_PreRinse" is used for detecting and displaying the 
maximum fill level of the pre-rinse tank. Process tag “LSH_PreRinse" is an 
instance of the "DMon" CMT with “In” variant selected. 

The following table shows the interconnections to other process tags and parameters: 
 

Block Connection Value Use 

In SimOn 1 Simulated process value active 

SimPV_In  Interconnection to simulated process 
value 
(Sim_Level_PostRTank\LSH.GE) 

S Out  Digital output value 
(LM_CIP\C002.Dig1; 
CIP_Return\CIP_RETURN.LS2_Out) 

 

LSL_PreRinse 

The display process tag “LSL_PreRinse" is used for detecting and displaying the 
minimum fill level of the pre-rinse tank. Process tag “LSL_PreRinse" is an instance 
of the "DMon" CMT with “In” variant selected. 

The following table shows the interconnections to other process tags and parameters: 
 

Block Connection Value Use 

In SimOn 1 Simulated process value active 

SimPV_In  Interconnection to simulated process 
value 
(Sim_Level_PreRTank\LSL.LE) 

 

4.2.6 Mixer 

The mixer is the part of the plant to be cleaned in the application example and is 
used to demonstrate the process. There are no process tags configured for the 
mixer in the application example. 
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Setup 

The figure below shows the design of the mixer: 
 

Mixer
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4.2.7 Mixer supply (TANK_IN) 

The detergent is fed from the CIP system into the mixer via the supply line. The type 
of detergent used is implemented by means of an SFC-type instance. The 
appropriate fluid is added to the mixer, depending on which control strategy is 
selected. The quantities added are defined by cleaning recipes in SIMATIC BATCH. 
The cleaning is carried out using cleaning batches and thus is also logged. 

Setup 

The figure below shows the design of the mixer supply: 
 

Tank In

 

The valves in the supply are opened and closed by an instance of the "TANK_IN" 
SFC type and the “PuPa_Mixer” process tag. 

The following table provides an overview of the elements and control module types 
used. 
 

Designation Technical function/ 
CMT 

Description 

TANK_IN "TANK_IN" SFC type Opening and closing the valves 
according to the specified control 
strategy 

LSH_Mixer “DMon” Acquisition of maximum fill level in mixer 
reached 

PuPa_Mixer  Process tag for pulsed activation of Drain 
valve 

YS_TankInDrain  “Val” Valve drain Process tag 

YS_TankInMix  “Val” Valve Inlet Mixer Process tag 
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Parameter assignment 

The parameter assignment for the individual process tags is described in the 
following. A detailed description of the SFC type can be found in Chapter 4.4.4, 
"Sequences". 

LSH_Mixer 

The “LSH_Mixer" display process tag is used for detecting and displaying the 
maximum fill level of the mixer. Process tag “LSH_Mixer" is an instance of the 
"DMon" CMT with “In” variant selected. 

The following table shows the interconnections to other process tags and parameters: 
 

Block Connection Value Use 

In SimOn 1 Simulated process value active 

SimPV_In  Interconnection to simulated process 
value 
(SimLevel_Mixer\LSH_Mixer.GE) 

 

PuPa_Mixer 

The “PuPa_Mixer" process tag is used for pulsed activation of the valve leading to 
the drain. In the Application Example, the control of the process tag is via the 
“TANK_IN” SFC type instance. The “PuPa_Mixer" process tag forwards the pulsed 
control command to the “YS_TankInDrain" process tag. 

The following table shows the interconnections to other process tags and parameters: 

 

Block Connection Value Use 

BlPuPa   Inserted as "PuPa_Mixer" for pulse/pause 
function 

STRENGH ModLiOp  Switchover of operating mode selection 
manual/switchover  
(Tank In\TANK_IN.PuPa_ModLiOp) 

 

Note When “PuPa_Mixer.ModLiOp” and “TANK_IN.PuPa1_ModLiOp” are 
interconnected, all other interconnections between the pulse/pause module and 
the SFC type instances are also created automatically. These are not listed in 
the above table. 

 



4 Structure and Principle of Operation 

4.2 Technical functions and process tags 
 

CIP - Cleaning in Place 
Entry ID: 78463886,    V3.0,    09/2016   50 
 


 S

ie
m

e
n

s
 A

G
 2

0
1

6
 A

ll 
ri

g
h

ts
 r

e
s
e

rv
e

d
 

YS_TankInDrain 

The valve that is activated by the “YS_TankInDrain” process tag controls the 
discharge of detergent to the drain. In the Application Example, the control of the 
process tag is via the “TANK_IN” SFC type instance and the “PuPa_Mixer” process 
tag. Process tag "YS_TankInDrain" is an instance of the “Val” control module type 
with the following selected variants: 

 FbkClose 

 FbkOpen 

 Permit 

 Opt_1Ctrl 

The process tag has been expanded to incorporate the following functions: 

 Or04 – “OpenYS_TankInDrain” 

 Or04 – “OpenYS_TankInDrain” 

 

The following table shows the interconnections to other process tags and parameters: 
 

Block Connection Value Use 

FbkOpen SimOn 1 Simulated process value active 

SimPV_In  Interconnection to simulated process value 
(SimYS_TankIndrain\SimFbkOpen.Out) 

FbkClose SimOn 1 Simulated process value active 

SimPV_In  Interconnection to simulated process value 
(SimYS_TankIndrain\SimFbkClose.InvOut) 

Ctrl SimOn 1 Simulated process value active 

SimPV_In  Interconnection to simulated process value 
(YS_TankInDrain\V.Ctrl) 

OpenYS_Drain In1  “Open” pulse 
(TANK IN\TANK_IN.V2_OpenAut) 

In2  “Open” pulse 
(PUPA_Mixer\PuPa_Mixer.ActGrp01) 

Out  “Open” pulse 
(YS_TankInDrain\V.OpenAut) 

CloseYS_Drain In1  “Close” pulse 
(TANK IN\TANK_IN.V2_OpenAut) 

In2  “Close” pulse 
(PUPA_Mixer\PuPa_Mixer.ActGrp01 
inverted) 

Out  “Close” pulse 
(YS_TankInDrain\V.CloseAut) 



4 Structure and Principle of Operation 

4.2 Technical functions and process tags 
 

CIP - Cleaning in Place 
Entry ID: 78463886,    V3.0,    09/2016   51 
 


 S

ie
m

e
n

s
 A

G
 2

0
1

6
 A

ll 
ri

g
h

ts
 r

e
s
e

rv
e

d
 

Block Connection Value Use 

V ModLiop  Switchover of operating mode selection 
manual/switchover  
(TANK IN\TANK_IN.V2_ModLiOp) 

Occupied  Occupied by batch  
(TANK IN\TANK_IN.QOCCUPIE) 

StepNo  Batch step number 
(TANK IN\TANK_IN.QSTEP_NO) 

BatchName  Batch name 
(TANK IN\TANK_IN.QBA_NA) 

BatchID  Batch Identification 
(TANK IN\TANK_IN.QBA_ID) 

BatchEn  Batch occupancy release 
(TANK IN\TANK_IN.QBA_EN) 

 

Note When “V.ModLiOp” and “TANK_IN.V2_ModLiOP” are interconnected, all other 
interconnections between the valve module and the SFC type instances are also 
created automatically. These are not listed in the above table. 

YS_TankInMix 

The valve that is activated by the “YS_TankInMix” process tag controls the supply 
of detergent to the mixer. In the Application Example, the control of the process tag 
is via the “TANK_IN” SFC type instance. Process tag “YS_TankInMix" is an 
instance of the “Val” control module type with the following selected variants: 

 FbkClose 

 FbkOpen 

 Permit 

 Opt_1Ctrl 

 

The following table shows the interconnections to other process tags and parameters: 

Block Connection Value Use 

FbkOpen SimOn 1 Simulated process value active 

SimPV_In  Interconnection to simulated process value 
(SimYS_TankInMix\SimFbkOpen.Out) 

FbkClose SimOn 1 Simulated process value active 

SimPV_In  Interconnection to simulated process value 
(SimYS_TankInMix\SimFbkClose.InvOut) 

Ctrl SimOn 1 Simulated process value active 

SimPV_In  Interconnection to simulated process value 
(YS_TankInMix\V.Ctrl) 
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Block Connection Value Use 

V OpenAut  Activation order for opening in automatic 
mode 
(TANK IN\TANK_IN.V1_OpenAut) 

Occupied  Occupied by batch  
(TANK IN\TANK_IN.QOCCUPIE) 

StepNo  Batch step number 
(TANK IN\TANK_IN.QSTEP_NO) 

BatchName  Batch name 
(TANK IN\TANK_IN.QBA_NA) 

BatchID  Batch Identification 
(TANK IN\TANK_IN.QBA_ID) 

BatchEn  Batch occupancy release 
(TANK IN\TANK_IN.QBA_EN) 

 

Note When “V.OpenAut” and “TANK_IN.V1_OpenAut” are interconnected, all other 
interconnections between the valve module and the SFC type instances are also 
created automatically. These are not listed in the above table. 

 

4.2.8 Mixer sequence 

The detergent is conducted back into the CIP system via the discharge from the mixer. 

Setup 

The figure below shows the design of the mixer outlet: 
 

Tank Out
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The valves in the outlet are opened and closed and the pump is started and 
stopped by an instance of the “TANK_OUT" SFC type. 

The following table provides an overview of the elements and control module types 
used. 
 

Designation Technical function/ 
CMT 

Description 

TANK_OUT “TANK_OUT" SFC type  Opening and closing valve 

 Starting and stopping the pump 

LSL_Mixer “DMon” Acquisition of minimum fill level in mixer 
reached 

YS_TankOutMix  “Val” Valve Mixer outlet Process tag 

NS_Mixer Mot Process tag for pump drive in mixer 
outlet 

Parameter assignment 

The parameter assignment for the individual process tags is described in the 
following. A detailed description of the SFC type can be found in Chapter 4.4, 
"Sequences". 

LSL_Mixer 

The “LSL_Mixer" display process tag is used for detecting and displaying the 
minimum fill level of the mixer. Process tag “LSL_Mixer" is an instance of the 
"DMon" CMT with “In” variant selected. 

The following table shows the interconnections to other process tags and parameters: 
 

Block Connection Value Use 

In SimOn 1 Simulated process value active 

SimPV_In  Interconnection to simulated process 
value 
(SimLevel_Mixer\LSL_Mixer.LE) 

 

NS_Mixer 

The pump that is activated by the “NS_Mixer" process tag pumps fluid from the 
mixer. In the Application Example, the control of the process tag is via the 
“TANK_OUT” SFC type instance. Process tag "NS_Mixer" is an instance of the 
“Mot” control module type with the following selected variants: 

 Permit 

 Opt_1Fbk 

 Start 
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The following table shows the interconnections to other process tags and parameters: 

Block Connection Value Use 

Fbk SimOn 1 Simulated process value active 

SimPV_In  Interconnection to simulated process 
value (SimNS_Mixer\SimFbkRun.Out) 

Start SimOn 1 Simulated process value active 

SimPV_In  Interconnection to simulated process 
value (NS_Mixer\U.Start) 

U StartAut  Starting order in automatic mode  
(TANK OUT\TANK_OUT.M1_StartAut) 

Occupied  Occupied by batch  
(TANK OUT\TANK_OUT.QOCCUPIE) 

StepNo  Batch step number 
(TANK OUT\TANK_OUT.QSTEP_NO) 

BatchName  Batch name 
(TANK OUT\TANK_OUT.QBA_NA) 

BatchID  Batch Identification 
(TANK OUT\TANK_OUT.QBA_ID) 

BatchEn  Batch occupancy release 
(TANK OUT\TANK_OUT.QBA_EN) 

 

 

Note When “U.StartAut” and “TANK_OUT.M1_StartAut” are interconnected, all other 
interconnections between the valve module and the SFC type instances are also 
created automatically. These are not listed in the above table. 

YS_TankOutMix 

The valve that is activated by the “YS_TankOutMix” process tag controls the 
discharge of detergent from the mixer. In the Application Example, the control of 
the process tag is via the “TANK_OUT” SFC type instance. Process tag 
“YS_TankOutMix" is an instance of the “Val” control module type with the following 
selected variants: 

 FbkClose 

 FbkOpen 

 Permit 

 Opt_1Ctrl 
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The following table shows the interconnections to other process tags and 
parameters: 

Block Connection Value Use 

FbkOpen SimOn 1 Simulated process value active 

SimPV_In  Interconnection to simulated process value 
(SimYSTankOutMix\SimFbkOpen.Out) 

FbkClose SimOn 1 Simulated process value active 

SimPV_In  Interconnection to simulated process value 
(SimYSTankOutMix\SimFbkClose.InvOut) 

Ctrl SimOn 1 Simulated process value active 

SimPV_In  Interconnection to simulated process value 
(YS_TankOutMix\V.Ctrl) 

V OpenAut  Opening order in automatic mode  
(TANK OUT\TANK_OUT.V1_OpenAut) 

Occupied  Occupied by batch  
(TANK OUT\TANK_OUT.QOCCUPIE) 

StepNo  Batch step number 
(TANK OUT\TANK_OUT.QSTEP_NO) 

BatchName  Batch name 
(TANK OUT\TANK_OUT.QBA_NA) 

BatchID  Batch Identification 
(TANK OUT\TANK_OUT.QBA_ID) 

BatchEn  Batch occupancy release 
(TANK OUT\TANK_OUT.QBA_EN) 

 

Note When “V.OpenAut” and “TANK_Out.V1_OpenAut” are interconnected, all other 
interconnections between the valve module and the SFC type instances are also 
created automatically. These are not listed in the above table. 

 

4.3 Interlocks 

The interlocking functions in the application example are generated with the PCS 7 
Logic Matrix. The following Interlocks are contained in the Application example: 

 Interlocking of valves to the tanks in return if the tanks are full 

 Interlocking of pump in supply if all of the valves are closed 

 Interlocking of fresh water valve to post-rinse tank if it is full 

 

Note Not all the interlocks that must be present in a real system are configured in the 
application example. The interlocks configured are solely for the purpose of 
illustrating the PCS 7 functions used. 
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Motor interlock, supply 

For its protection, the motor is interlocked in supply if all the valves are closed.  
As soon as a valve is opened, the interlocking is stopped. With the jump keys it is 
possible to navigate from the motor measuring point display block to the process 
tag causing the interlock. 

The following figures show the interlock and the navigation to the cause of the 
interlocking: 

1. Initially the motor is interlocked. 

 

 

2. Clicking on the “Interlock" button the display block of the corresponding 
interlock block opens. 
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3. The interlock block displays the interlocks. 

4. Using the jump keys it is possible to navigate to the cause. 

 

 

5. The PCS 7 Logic Matrix opens with the filter preset for the activated effect. 

 

 

6. Left-clicking on the “magnifying glass” opens the Cause display block. 
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7. Via the Cause display block you can jump to the process tag that has caused 
the interlocking. 

 

 

8. In the Faceplate of the process tag causing the interlocking you can rectify the 
cause (in the Application example by opening the valve). 
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9. After the cause of the interlocking has been rectified the interlock is removed. 

 

 

With the settings of the PCS 7 Logic Matrix it is possible to determine whether the 
interlock is removed automatically or must be removed manually. 

 

Note You can find detailed information about the PCS 7 Logic Matrix in the "SIMATIC 
Process Control System PCS 7 Logic Matrix” manual  
(https://support.industry.siemens.com/cs/ww/en/view/109737083) 
and in the Application example “Efficient Configuration of Interlock Logics with 
PCS 7 Logic Matrix“ 
(https://support.industry.siemens.com/cs/ww/en/view/109482621) 

 

 

https://support.industry.siemens.com/cs/ww/de/view/109737083
https://support.industry.siemens.com/cs/ww/de/view/109482621
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4.4 Sequences (SFC type instances) 

The CIP system is designed for batch operation. Within the system there are various 
SFC-type instances with diverse tasks. According to ISA 88, the SFC-type instance 
describes the equipment module. These will be described in the following sections. 

The following table provides you with an overview of the SFC types present in the 
application example. 
 

SFC type Comment 

CIP_RETURN Control of CIP system return 

CIP_SUPPLY Control of CIP system supply 

FILL_HEAT_CONC Control of fluid reprocessing in detergent 
tank (no BATCH functionality) 

TANK_IN Control for the supply to the mixer 

TANK_OUT Control for the mixer discharge 

 

4.4.1 CIP_RETURN 

The SFC type instance is started by SIMATIC BATCH in the cleaning recipes and 
opens or closes the valves in the return line of the CIP system which lead to the 
tanks and the drain. This takes place according to the selected control strategy 
(defined in the recipe) and the quality of the fluid. 

Control Strategies 

The control strategies for the "CIP_RETURN" SFC type are listed in the following table: 

Control strategy Comment 

PRERINSE Control strategy for pre-rinse phase 

DETERGENT Control strategy for wash phase 

POSTRINSE Control strategy for post-rinse phase 

 

Set points 

The setpoints for the "CIP_RETURN" SFC type are listed in the following table: 

Setpoint name Data type Connection 
name 

Unit Comment 

TEMP_PRERINSE REAL PRE_TMP °C Temperature of 
pre-rinse fluid 

TEMP_DETERGENT REAL DET_TMP °C Temperature of 
washing fluid 

HYSTERESIS_TEMP REAL T_HYS °C Temperature 
hysteresis 
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Setpoint name Data type Connection 
name 

Unit Comment 

PRE_CON REAL PRE_CONC mS Detergent 
concentration in 
pre-rinse fluid 

DET_CONC REAL DET_CONC mS Detergent 
concentration in 
washing fluid 

HYSTERESIS_CONC REAL C_HYS mS Concentration 
hysteresis 

 

Control values 

The control values for the "CIP_RETURN" SFC type are listed in the following table: 

Control value 
name 

Data type Connection 
name 

Start value Comment 

SetTempRet BOOL SetTempRet FALSE Reset command 
for simulation 
values 

 

Note In the Application example the “SetTempRet” Control value serves the purpose 
of resetting the simulated process values “Temperature” and “Conductivity” of 
the liquid in the CIP return to a defined Start value. 

 

Block contacts 

The block contacts for the "CIP_RETURN" SFC type are listed in the following table: 

Name Block Connection name Comment 

V1 VlvL V1 Valve to pre-rinse tank 

V2 VlvL V2 Valve to detergent 
tank 

V3 VlvL V3 Valve to the drain 

LS1 MonDiL LS1 Level monitoring in 
pre-rinse tank 

LS2 MonDiL LS2 Level monitoring in 
detergent tank 

 

Sequences 

The following sequences are configured in the “CIP_RETURN” SFC type: 

 PRERINSE 

 DETERGENT 

 POSTRINSE 

 COMPLETING_ABORT 
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COMPLETING_ABORT 

The "COMPLETING_ABORT" sequence performs the following actions: 

 Closes all valves in the return line and enables their manual operation 

 Sets the SFC-type to “IDLE” 

 

The start conditions for the "COMPLETING_ABORT" sequence are listed in the 
following table: 

SFC status = Value Logic 

ABORTING = Aborting 
OR 

COMPLETING = Completing 

 

The figure below shows the design of the “COMPLETING_ABORT” sequence: 

Alle Ventile zu den Tanks 
und Ventil zum Kanal 

schließen

Start
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PRERINSE 

The "PRERINSE" sequence performs the following actions in the pre-rinse phase: 

 Resets valves in the return line 

 Sets Mode selection of valves to “via interconnection” 

 Switches valves in the return line to automatic mode 

 Closes all the valves to the tanks 

 Opens the valve to the drain 

 Sets the SFC type to the "Ready to Complete" state at the end of processing 

 

The start conditions for the "PRERINSE" sequence are listed in the following table: 

SFC status = Value Logic 

RUN = Run 

AND QCS = 1 

READY_TC = 0 

 

The “PRERINSE” sequence remains active until it is terminated by the higher level 
controller (SIMATIC BATCH). 
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The figure below shows the design of the “PRERINSE” sequence: 
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DETERGENT 

The "DETERGENT" sequence performs the following actions in the wash phase: 

 Resets valves in the return line 

 Sets Mode selection of valves to “via interconnection” 

 Switches valves in the return line to automatic mode 

 Opens or closes the valves depending on the fill levels in the tanks and the 
quality of the fluid 

 Sets the SFC type to the "Ready to Complete" state (in each "valve step") 

There is a separate step ("valve step") for each valve that is opened or closed. In 
this step, the corresponding valve is opened and all other valves are closed. In the 
subsequent transition, a check is made to see whether the conditions have 
changed. If the conditions have changed, the sequence jumps accordingly to 
another valve step. 
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The calculation of the conditions is carried out in the SFC-type directly, as shown in 
the following figures. 

 

 

 

 

Note The calculations of all other conditions in this and other SFC types are carried 
out according to the same principle and are not described in the application 
example. 

You can find detailed information on calculations in the SFC in the manual 
"SIMATIC Process Control System PCS 7 – SFC for SIMATIC S7 (V8.2), 
Chapter 12.4.5 “Calculations in steps and transitions of SFC”.  
https://support.industry.siemens.com/cs/ww/en/view/109736726 

 

https://support.industry.siemens.com/cs/ww/de/view/109736726
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The start conditions for the "DETERGENT" sequence are listed in the following table: 

SFC status = Value Logic 

RUN = Run 

AND QCS = 2 

READY_TC = 0 

 

The “DETERGENT” sequence remains active until it is terminated by the higher 
level controller (SIMATIC BATCH). 

The figure below shows the design of the “DETERGENT” sequence: 
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POSTRINSE 

The "POSTRINSE" sequence performs the following actions in the wash phase: 

 Resets valves in the return line 

 Sets Mode selection of valves to “via interconnection” 

 Switches valves in the return line to automatic mode 

 Opens or closes the valves depending on the fill levels in the tanks and the 
quality of the fluid 

 Sets the SFC type to the "Ready to Complete" state (in each "valve step") 

There is a separate step ("valve step") for each valve that is opened or closed. In 
this step, the corresponding valve is opened and all other valves are closed. In the 
subsequent transition, a check is made to see whether the conditions have 
changed. If the conditions have changed, the sequence jumps accordingly to 
another valve step. 

The start conditions for the "POSTRINSE" sequence are listed in the following table: 

SFC status = Value Logic 

RUN = Run 

AND QCS = 3 

READY_TC = 0 

 

The “POSTRINSE” sequence remains active until it is terminated by the higher level 
controller (SIMATIC BATCH). 

The design of the "POSTRINSE" sequence is identical to that of the "DETERGENT" 
sequence. 

4.4.2 CIP_SUPPLY 

The SFC type instance is started by SIMATIC BATCH in the cleaning recipes and 
opens or closes the valves from the tanks of the CIP system which lead to the 
supply line. This takes place according to the selected control strategy defined in 
the recipe. Additionally the pump is started in supply. The setpoint of the flow rate 
is defined in the recipe. Before the fluid is drawn from the tanks, a check is made to 
ensure that the relevant conditions are satisfied. 

Control Strategies 

The control strategies for the "CIP_SUPPLY" SFC type are listed in the following table: 

Control strategy Comment 

PRERINSE Control strategy for pre-rinse phase 

DETERGENT Control strategy for wash phase 

POSTRINSE Control strategy for post-rinse phase 

 

Set points 

The setpoints for the "CIP_SUPPLY" SFC type are listed in the following table: 
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Setpoint name Data type Connection 
name 

Unit Comment 

RINSE_TIME REAL RINSE_TIME S Duration of the 
phase 

RINSE_FLOW REAL RINSE_FLOW m³/h Flow rate of fluid 

 

Process values 

The process values for the "CIP_SUPPLY" SFC type are listed in the following table: 

Name Data type Connection name Comment 

FCH_Level_Check BOOL FCH_Level Sufficient fluid present 

FCH_RUN BOOL FCH_RUN Fluid reprocessing is 
active 

FCH_HOLD BOOL RCH_HOLD Fluid reprocessing is 
halted 

 

Control values 

The control values for the "CIP_SUPPLY" SFC type are listed in the following table: 

Name Data type Connection name Comment 

Hold_LHC BOOL Hold_LHC Fluid reprocessing is 
halted 

Resume_LHC BOOL Resume_LHC Fluid flow resume 

 

Information texts 

The information texts for the "CIP_SUPPLY" SFC type are listed in the following table: 

Name Number Displayed text Comment 

Tanks 1 CIP Tanks ready? Information to the 
effect that fluid is not 
reprocessed / 
reprocessing has 
not started yet. 

 

Block contacts 

The block contacts for the "CIP_SUPPLY" SFC type are listed in the following table: 

Name Block Connection name Comment 

V1 VlvL V1 Valve to pre-rinse 
tank 

V2 VlvL V2 Valve to detergent 
tank 

V3 VlvL V3 Valve to post-rinse 
tank 

M1 MotL M1 Supply pump 

TIMER1 BlTimer TIMER1 Supply timer 
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Sequences 

The following sequences are configured in the SFC type „CIP_SUPPLY“: 

 PRERINSE 

 DETERGENT  

 POSTRINSE 

 COMPLETING_ABORT 

 Holding 

 Resuming 

The instance of the "CIP SUPPLY" SFC type is connected to the “RinseTimer" 
block. This ensures that the specified exposure time for the cleaning fluid in the 
plant section to be cleaned is maintained. The “RinseTimer" block is an instance of 
the "BlTimer" function block from the BRAUMAT library. 

PRERINSE 

The "PRERINSE" sequence performs the following actions in the pre-rinse phase: 

 Checks that the pre-rinse fluid meets the quality requirements and is available 
in sufficient quantity. 

 Stops fluid reprocessing 

 Switches all the valves and the pumps to automatic mode 

 Closes the valves from the detergent and post-rinse tanks 

 Opens valve of pre-rinse tank 

 Starts pump at set speed 

The start conditions for the "PRERINSE" sequence are listed in the following table: 

SFC status = Value Logic 

RUN = Run 
AND 

QCS = 1 

 

The sequence remains active until the time specified on the timer has elapsed. 

 

The figure below shows the design of the “PRERINSE” sequence: 
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DETERGENT 

The "DETERGENT" sequence performs the following actions in the wash phase: 

 Checks that the detergent fluid meets the quality requirements and is available 
in sufficient quantity. 

 Stops fluid reprocessing 

 Switches all the valves and the pumps to automatic mode 

 Closes valves of pre-rinse and post-rinse tank 

 Opens valve of detergent tank 

 Starts pump at set speed 

 Starts the timer 

The start conditions for the "DETERGENT" sequence are listed in the following table: 

SFC status = Value Logic 

RUN = Run 
AND 

QCS = 2 
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The sequence remains active until the time specified on the timer has elapsed. 

The design of the "DETERGENT" sequence is like that of the "PRERINSE" 
sequence, with the following differences: 

 The valve to the pre-rinse tank closes 

 Valve to the detergent tank opens 

 

POSTRINSE 

The “POSTRINSE” sequence carries out the following actions in the post-rinse phase: 

 Checks that the post-rinse fluid meets the quality requirements and is available 
in sufficient quantity 

 Stops fluid reprocessing 

 Switches all the valves and the pumps to automatic mode 

 Closes the valves from the pre-rinse and detergent tank 

 Opens valve of post-rinse tank 

 Starts pump at set speed 

The start conditions for the "POSTRINSE" sequence are listed in the following table: 

SFC status = Value Logic 

RUN = Run 
AND 

QCS = 3 

 

The sequence remains active until the time specified on the timer has elapsed. 

The design of the "POSTRINSE" sequence is like that of the "PRERINSE" 
sequence, with the following difference: 

 The valve to the pre-rinse tank closes 

 Valve to the detergent tank opens 

Completing_Abort 

The "Completing_Abort" sequence performs the following actions: 

 Stops pump in supply 

 Resumes fluid reprocessing 

 Closes all the valves in supply 

 Resets the Timer 

 Enables manual operation of valve and pump 

The start conditions for the "Completing_Abort" sequence are listed in the following table: 

SFC status = Value Logic 

ABORTING = Aborting 
OR 

COMPLETING = Compliti 
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The figure below shows the design of the “Completing_Aborting” sequence: 
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Holding 

The “Holding" sequence performs the following actions: 

 Stops the pump in supply 

 Stops the Timer (indirectly through status “HELD = Held”) 

The following table lists the starting conditions of the “Holding” sequence: 

SFC status = Value Logic 

HOLDING = Holding AND 
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The figure below shows the design of the “Holding” sequence: 
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Resuming 

The “Resuming" sequence performs the following actions: 

 Starts the pump in supply 

 Starts Timer (indirectly through status “HELD = 0”) 

The start conditions for the "Resuming" sequence are listed in the following table: 

SFC status = Value Logic 

RESUMING = Resuming AND 

 

The figure below shows the design of the “Resuming” sequence: 
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4.4.3 FILL_HEAT_CONC 

The SFC-type instance is started by the operator. It must be permanently active so that 
the cleaning fluid is always available in sufficient quantities of the prescribed quality. 

By means of the "FHC" SFC-type instance from the "FILL_HEAT_CONC" SFC-
type, the fill level, the temperature and the detergent concentration of the fluid are 
determined and adjusted as required. 

The fluids in the pre- and post-rinse tanks are not reprocessed in the "CIP" 
application example. These fluids can be reprocessed with the 
"FILL_HEAT_CONC" SFC type. 

Control Strategies 

The control strategies for the "FILL_HEAT_CONC" SFC type are summarized in 
the following table: 

Control strategy Comment 

PREPARE Reprocessing of the fluid 

 

Set points 

The control strategies for the "FILL_HEAT_CONC" SFC type are summarized in 
the following table: 

Setpoint name Data type Connection 
name 

Unit Comment 

LEVEL REAL LEVEL L Tank fill level 

HYSTERESIS_Level REAL L_HYS L Fill level 
hysteresis 

TEMPERATURE REAL TEMP °C Temperature of 
fluid 

HYSTERESIS_Temp REAL T_HYS °C Temperature 
hysteresis 

CONCENTRATION REAL CONC mS Detergent 
concentration 

HYSTERESIS_Conc REAL C_HYS mS Concentration 
hysteresis 

 

Control values 

The control values for the "FILL_HEAT_CONC" SFC type are listed in the following 
table: 

Name Data type Connection name Comment 

LEVEL_CHECK_1 BOOL L_CHECK Fill level OK 

 

Block contacts 

The block contacts for the "FILL_HEAT_CONC" SFC type are listed in the following 
table: 
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Name Block Connection name Comment 

V1 VlvL V1 Fresh water valve 

V2 VlvAnL V2 Temperature 
regulation valve 

M1 MotL M1 Circulation pump 
motor 

M2 MotL M2 Metering pump motor 

LS1 MonDiL LS1 Level monitoring high 

LS2 MonDiL LS2 Level monitoring low 

PID1 PIDConL PID1 Temperature 
controllers 

PuPa1 BlPuPa PuPa1 Pulse/pause for 
metering 

 

Sequences 

The following sequences are configured in the "FILL_HEAT_CONC" SFC type: 

 PREPARE 

 Aborting 

PREPARE  

The "PREPARE" sequence performs the following actions: 

 Sets the valves and pumps to automatic mode. 

 Checks the fill level and tops up the fluid. 

 Measures the temperature of the fluid and controls it 

 Measures the concentration of the detergent and controls it 

The sequence is started by the operator. 

The start conditions for the "PREPARE" sequence are listed in the following table: 

SFC status = Value Logic 

RUN = Run 
AND 

QCS = 1 

 

The procedure of the sequence remains active until it is stopped by the operator. At 
the start of a wash phase the sequence is halted, and at the end of the wash phase 
it is resumed.  

In the sequence, a check is first made as to whether the fill level is adequate or if it 
needs to be readjusted. If the fill level is adequate, a check is made as to whether 
the temperature is high enough or if it needs to be readjusted If the fill level and the 
temperature are set, the concentration of the detergent is checked and readjusted 
as necessary. 

The detergent is metered with the aid of the BlPuPa block (BRAUMAT library) 
which is connected to the SFC type instance. This is used to pulse-drive the 
metering pump over a predefined cycle. 

The following four figures show the structure of the “PREPARE” sequence: 
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Sequence of the actions: 

 Set the valves and pumps to automatic mode 

 Start the circulation pump 

 Check the fill level 

 Adjust the fill level or jump to the step for checking the temperature or the concentration 

is illustrated in the following diagram: 
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Sequence of the actions: 

 Set the fill level (open /close the fresh water valve) 

 Check the temperature 

 Adjust the temperature or jump to the step for checking the fill level or the concentration 

is illustrated in the following diagram: 
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Sequence of the actions: 

 Set the temperature (make the fluid circulate) 

 Check the concentration  

 Adjust the concentration or jump to the step for checking the fill level 

is illustrated in the following diagram: 
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Sequence of the actions: 

 Set the concentration (start pulse/pause control of the metering pump) 

 Check the concentration  

 Start metering again or jump to the step for checking the fill level 

is illustrated in the following diagram: 
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Aborting 

The “Aborting" sequence performs the following actions: 

 Closes all the valves 

 Stops all the pumps 

 Enables manual operation of all process tags controlled 

The start conditions for the "Aborting" sequence are listed in the following table: 

SFC status = Value Logic 

ABORTING = Aborting AND 
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The figure below shows the design of the “Aborting” sequence: 
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4.4.4 TANK_IN 

The SFC-type instance is started by SIMATIC BATCH in the cleaning recipes and 
opens or closes the valve to the mixer. In addition the “BlPuPa” for opening and 
closing the valve to the drain is activated. The setting of the pulse times and 
number is defined in the recipe.  

Control strategy 

The control strategies for the "TANK_IN" SFC type are listed in the following table: 

Control strategy Comment 

PRODUCTION Control strategy for production 

CIP Control strategy for cleaning the mixer 

 

Set points 

The setpoints for the "TANK_IN" SFC type are listed in the following table: 

Setpoint name Data type Connection 
name 

Unit Comment 

Loops DINT Loop  Number of loops 

Loop_Time REAL Loop_Time S Duration of a 
loop 
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Block contacts 

The block contacts for the "TANK_IN" SFC type are listed in the following table: 

Name Block Connection name Comment 

V1 VlvL V1 Mixer valve 

V2 VlvL V2 Drain valve 

PUPA BlPuPa PUPA Connection for 
pulse/pause block 

Sequences 

The following sequences are configured in the "TANK_IN" SFC type: 

 PRODUCTION 

 CIP 

 COMPLETING_ABORT 

PRODUCTION 

The "PRODUCTION" sequence performs the following actions: 

 Sets Mode selection of valves to “via interconnection” 

 Switches valves to automatic mode 

 Opens the valve to the mixer 

The start conditions for the "PRODUCTION" sequence are listed in the following table: 

SFC status = Value Logic 

RUN = Run 
AND 

QCS = 1 

 

The “PRODUCTION” sequence remains active until it is terminated by the higher 
level controller (SIMATIC BATCH). 
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The figure below shows the design of the “PRODUCTION” sequence: 
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CIP 

The "CIP" sequence performs the following actions: 

 Sets Mode selection of valves and pulse/pause block to “via interconnection” 

 Sets the valves and the pulse-pause block to automatic mode 

 Opens the valve to the mixer 

 Starts the pulse/pause block 

The start conditions for the "CIP" sequence are listed in the following table: 

SFC status = Value Logic 

RUN = Run 
AND 

QCS = 2 

 

The “CIP” sequence remains active until it is terminated by the higher level 
controller (SIMATIC BATCH). 
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The figure below shows the design of the “CIP” sequence: 
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COMPLETING_ABORT 

The "COMPLETING_ABORTING" sequence performs the following actions: 

 Closes all the valves  

 Enables manual operation of valve and Pulse-Pause block 

The start conditions for the "COMPLETING_ABORTING" sequence are listed in 
the following table: 

SFC status = Value Logic 

ABORTING = Aborting 
OR 

COMPLETING = Compliti 
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The figure below shows the design of the “COMPLETING_ABORTING” sequence: 
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4.4.5 Tank_OUT 

The SFC type instance is started by SIMATIC BATCH in the cleaning recipes and 
opens or closes the discharge valve from the mixer and starts or stops the pump 
for pumping out the mixer.  

Control strategy 

The control strategies for the "TANK_OUT" SFC type are listed in the following table: 

Control strategy Comment 

PRODUCTION Control strategy for production 

CIP Control strategy for cleaning the mixer 

Block contacts 

The block contacts for the "TANK_OUT" SFC type are listed in the following table: 

Name Block Connection name Comment 

V1 VlvL V1 Mixer valve 

V2 VlvL V2 Drain valve 

M1 MotL M1 Motor for pump 
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Sequences 

The following sequences are configured in the “TANK_OUT" SFC type: 

 PRODUCTION 

 CIP  

 COMPLETING_ABORT 

 HOLDING 

 RESUMING 

 

PRODUCTION 

The "PRODUCTION" sequence performs the following actions in the pre-rinse phase: 

 Sets Mode selection of valve and motor to “via interconnection” 

 Sets the valve and the motor to automatic mode 

 Opens valve and starts motor 

The start conditions for the "PRODUCTION" sequence are listed in the following table: 

SFC status = Value Logic 

RUN = Run 
AND 

QCS = 1 

 

The “PRODUCTION” sequence remains active until it is terminated by the higher 
level controller (SIMATIC BATCH). 
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The figure below shows the design of the “PRODUCTION” sequence: 
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CIP 

The "CIP" sequence performs the following actions: 

 Sets Mode selection of valve and motor to “via interconnection” 

 Sets the valve and the motor to automatic mode 

 Opens valve and starts motor 

The start conditions for the "CIP" sequence are listed in the following table: 

SFC status = Value Logic 

RUN = Run 
AND 

QCS = 2 

 

The “CIP” sequence remains active until it is terminated by the higher level controller 
(SIMATIC BATCH). 
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The figure below shows the design of the “CIP” sequence: 
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COMPLETING_ABORT 

The "COMPLETING_ABORTING" sequence performs the following actions: 

 Stops motor and closes the valve  

 Enables manual operation of valve and motor 

The start conditions for the "COMPLETING_ABORTING" sequence are listed in 
the following table: 

SFC status = Value Logic 

ABORTING = Aborting 
OR 

COMPLETING = Compliti 
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The figure below shows the design of the “COMPLETING_ABORTING” sequence: 
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HOLDING 

The “HOLDING” sequence stops the motor. 

The start conditions for the "HOLDING" sequence are listed in the following table: 

SFC status = Value Logic 

HOLDING = Holding AND 

 

The figure below shows the design of the “HOLDING” sequence: 
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RESUMING 

Die Sequence “RESUMING” starts the motor. 
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The start conditions for the "Resuming" sequence are listed in the following table: 

SFC status = Value Logic 

RESUMING = Resuming AND 

 

The figure below shows the design of the “RESUMING” sequence: 
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4.5 SIMATIC BATCH 

SIMATIC BATCH is used for discontinuous production. With the aid of SIMATIC 
BATCH, various products can be produced in one plant. Manufacture is carried out 
by means of recipes. The recipes contain the knowledge required for production. 
The recipes can be modified by the operating personnel. The complete recipe 
procedure with messages and measured values, as well as the operator 
interventions, is logged. 

In addition to the recipes for manufacturing the product, there are also recipes that 
are used for cleaning the plant units. 

4.5.1 Cleaning recipes 

Cleaning recipes are used for cleaning the plant sections that are necessary for 
production. 

Information contained in the recipe 

The following information may be contained in the cleaning recipe: 

 Plant section to be cleaned 

 The duration of the cleaning (setpoints for the length of time the fluids remain 
in the plant section) 

 The temperature of the cleaning fluid 

 The detergent concentration in the cleaning fluid 

 The quantity of cleaning fluid (flow rate) 
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Various cleaning recipes can be created for a plant section. These differ in the 
above-mentioned points. These differences depend, e.g., on the degree of soiling 
of the plant or on the product that was previously contained in the plant. 

Structure of an example recipe 

The "CIP Mixer" sample cleaning recipe in the "CIP" application example is 
intended for cleaning the "Mixer" plant section. It consists of the "TRP MIXER" and 
"TRP CIP" recipe unit procedures (TRP). 

The table below lists the TRPs of the “CIP Mixer” cleaning recipe: 

TRP Occupied plant section 

RUP Mixer MIXER 

RUP CIP CIP 

 

For each TRP there exist three recipe operations (ROP): "PRERINSE", 
"DETERGENT" and "POSTRINSE". The names of the recipe operations 
correspond to the current cleaning phase. The recipe phases (RFs) are called up 
within the ROPs. Each ROP contains two RFs, which run in parallel. 

The table below lists the RFs of the “CIP Mixer” cleaning recipe: 

TRP ROP RF Control strategy 

MIXER PRERINSE TANK_IN CIP 

TANK_OUT CIP 

DETERGENT TANK_IN CIP 

TANK_OUT CIP 

POSTRINSE TANK_IN CIP 

TANK_OUT CIP 

CIP PRERINSE CIP_SUPPLY PRERINSE 

CIP_RETURN PRERINSE 

DETERGENT CIP_SUPPLY DETERGENT 

CIP_RETURN DETERGENT 

POSTRINSE CIP_SUPPLY POSTRINSE 

CIP_RETURN POSTRINSE 

 

There are synchronization lines between the ROPs so that the process runs 
synchronously in the TRPs. There is a NOP step at the end of the recipe. This is 
necessary so that the last two ROPs will also run synchronously with one another. 
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The figure below describes the structure of the cleaning recipe contained in the 
“CIP” Application example: 

 

 

4.5.2 Cleaning batches 

The cleaning batches are created as requests in SIMATIC BATCH. The recipe for 
cleaning is defined when the batch is created. 

It is possible to start the cleaning batch automatically immediately at the end of a 
production batch. This ensures that the plant is clean again after the production of 
a product and can be used for further production. 
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5 Starting the Application Example 

5.1 Preparation 

The following instructions describe how to launch the application example by 
emulating the controller with the "S7 PLCSIM" program. If there is a real controller, 
you must configure existing hardware components in HW Config. 

Preparation in Windows 

The following instructions describe the steps that must be performed in Windows: 

1. Click on "Start". 

2. Right-click on "Computer" and open the "Administrate" menu item. The 
Computer Management dialog opens. 

3. Right-click on the left side of the window on the "Local users and groups > 
Groups" menu item. Select the "New group" menu command. The “New Group” 
window then opens. 

4. Enter "CIPDemoUser" in the "Names" box. 

5. Add the user name with which you are currently logged in to Windows to this 
group. 

6. Click on "Create". 

7. On the left side of the window, select the "Local users and groups" item. On 
the right side, right-click on the user name with which you are currently logged 
in. Select the "Properties" menu item. This opens the "Properties" window. 
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8. Switch to the "Member of" tab and check whether the user is a member of the 
listed groups: 

 
If the user is not included in all the groups, add him to the missing ones. 

Preparing the project 

1. Copy the file "78463886_PRO_CIP_PCS7_V82.zip" and 
“78463886_CIP_PCS7_BATCH_BACKUP.sbb” into any folder on the 
configuration PC and then open the SIMATIC Manager. 

2. Click on "File > Retrieve" in the menu bar and select the file 
"78463886_PRO_CIP_PCS7_V82.zip". Then confirm with "Open". 

3. Select the folder in which the project will be saved and confirm with the "OK" 
button. 
The project will be extracted. 

4. In the "Retrieve" dialog, click on the "OK" button and then click on "Yes" in the 
dialog to open the project. 

5. Right-click on “UT_CIP_OS > PCS7ES" and click on the "Object properties" 
menu item. 
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6. Enter the name of your PC in the "Name" box and click on "OK". 

 
 

7. Right-click on “UT_CIP_OS > Name of your PC > WinCC Appl > OS (1)" and 
click on the "Open object" menu command. 

8. Confirm the "Configured server not available" dialog with "OK". 

9. In the WinCC Explorer, open the properties of your PC and, in the opened 
Properties dialog, click on the "Use local computer name" button. Confirm the 
"Change computer name" message with "OK". 

 

10. In the WinCC Explorer, click on "File > Exit" and in the subsequent dialog 
select "Terminate WinCC Explorer and close project". Confirm your selection 
clicking on the "OK” button. 

11. Reopen the WinCC Explorer as described in step 7. 

12. Open by double-clicking the "OS project editor". 
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13. In the "Layout" tab under "Available layouts", select the "SIMATIC Standard" 
screen corresponding to the screen resolution that is set. 

 

 

Click on "OK" to accept the settings and close the "OS project editor". 

14. Exit WinCC Explorer as described in step 10. 
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5.2 Working on the multiproject 

The following instructions describe the work that must be performed on the 
multiproject. It is necessary that SIMATIC Manager already be open and the 
project must have been selected in the component view. 

1. Right-click on “UT_CIP_AS > AS1 > CPU 410-5H > S7-program (1) > Charts” 
and click the menu command "Compile". 

2. In the "Compile program" dialog, select the "Entire program" item and 
deactivate the "Generate module drivers" option then confirm it with "OK". 

 

 

3. Close the compiler log. 

4. Right-click on “UT_CIP_OS > PCS7ES (Name of PC station) > WinCC Appl > 
OS (1)” and click on the menu point “Compile”. The compiler dialog opens. 

5. Click on "Next". 

6. Click on "Next". 
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7. Make sure that all areas are selected and click on "Next". 

 

 

8. Select the following settings and click on “Next”. 

 

 

9. Click on “Compile". 

10. Confirm the "Compile OS" dialog with "OK". 

11. In SIMATIC Manager, right click on the "UT_CIP_MP" multiproject and select 
the "SIMATIC BATCH > Open configuration dialog" menu command. The 
SIMATIC BATCH configuration dialog opens.  
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12. Select the "UT_CIP_MP" multiproject and click on “Settings". 
 

 

 

The "Settings" window opens. 

13. In the "Distribution" tab, click on "Update". 

 

 

14. In the "OS objects" tab, click on "Update". 
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15. In the "Process cells" tab, click on "Update". 

 

 

16. Click on "OK" to quit the "Settings" window. 

17. Select the "BATCH types" item and click on "Generate”. 

18. Click on "Start". 

19. Click on "Close". 
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20. Select the "BATCH instances" item and click on "Merge". 

21. Click on "Start". 

22. Click on "Close". 

 

 

23. Select the "PRODUCTION" item and click on "Download". 

24. Click on "Start". 

25. Click on "Close". 

 

 

26. Exit the SIMATIC BATCH configuration dialog with "OK". 
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27. In the windows task bar, right-click on the icon for the SIMATIC BATCH 
Launch Coordinator and select the "Change start mode from > Automatic to 
manual" menu command. 

 

 

Note The SIMATIC BATCH Launch Coordinator starts automatically when the PC is 
started. If SIMATIC BATCH Launch Coordinator does not start, proceed as 
follows: 

Click on "Start > All programs > Siemens Automation > SIMATIC > BATCH 
Launch Coordinator". 

5.3 Commissioning 

The following instructions describe how the "CIP" application example is initialized: 

For commissioning, it is required that SIMATIC Manager is already open and that 
the project has been selected in the component view. 

Starting the emulation (S7 PLCSIM) 

To start the emulation, proceed according to the following instructions: 

1. Select "Extras > Simulate module" from the menu. 
The "S7 PLCSIM" dialog window opens. 

2. In the menu, select "Execute > Key-switch position > Run-P". 

3. Switch to the component view of SIMATIC Manager and select "UT_CIP_MP > 
UT_CIP_AS > AS1 > CPU 410-5H > S7-program > Charts“. 

4. Click on “Target system > Download” in the menu bar. 

5. Confirm the "Load" dialog with "Yes". 

6. Confirm the "Stop target group" dialog with "OK”. 

7. Confirm the "Load" dialog with "Yes". 

Activate OS (WinCC runtime) 

To activate the OS, proceed according to the following instructions: 

1. Right-click on "UT_CIP_OS > PCS7ES > WinCC Appl. > OS" and then click on 
the menu command "Open object". 

2. Select "File > Activate" in the WinCC Explorer menu. 
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3. Log into the SIMATIC Logon Dialog using your Windows user ID. 

 

 

4. Select "CIP" in the icon area. 

 

 

Activating SIMATIC BATCH 

To activate SIMATIC BATCH, proceed according to the following instructions: 

1. Click on the Windows logo key on your keyboard to bring up the Windows task 
bar. 

2. There is a green "Stop" symbol in the icon for the SIMATIC BATCH Launch 

Coordinator . The currently loaded "UT_CIP_MP" project is displayed as a 
tool-tip text. 
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3. Right-click on the icon for the SIMATIC BATCH Launch Coordinator and select  
the "BATCH Runtime > Start" menu command to start SIMATIC BATCH Runtime. 

 

 

There will be an "hourglass"  in the icon for the SIMATIC BATCH Launch 
Coordinator. This indicates that the SIMATIC BATCH server is about to be started. 

The "hourglass" turns into a "Play" symbol . The SIMATIC BATCH server is 
now in the "Run" state. 

 

4. Click on "Start > All programs > Siemens Automation > SIMATIC > BATCH 
Control Center". 
The BATCH Control Center opens. 

5. Click on the "Extras" menu item and select the "Restore" menu command. 
The Restore dialog opens. 
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6. Navigate to the storage location of the 
"78463886_CIP_PCS7_BATCH_BACKUP" file and select it.  

7. Click on "Open". 

8. Click on the "PRODUCTION" process cell symbol and click on the menu 
command "Update the process cell". 

9. Confirm the "Update the plant" dialog with "OK". 

10. Click on the "Extras" menu item and select the "Role Management" menu 
command. 
The "SIMATIC Logon Role Management" dialog opens. 
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11. In the "Configured roles and assignment types" window, right-click on "Roles > 
Superuser > Groups and users". Select the "Edit" menu command. 

 

 

The "Edit groups and users" window will open. 

12. Click on the “List" button. 
All the available groups and users will be listed for you. 

13. Remove the User that is present. 

14. Add the group "CIPDemoUsers" to "Configured groups and users". 

15. Click on the "OK" button to exit the "Edit groups and users" window. 

16. In the "SIMATIC Logon Role Management" window, click on "File > Save". 

17. In the "SIMATIC Logon Role Management" window, click on "File > Exit". 
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6 Operation and control of the Application 
Example 

6.1 Overview 

The following sections describe the operation of the application example. Three 
different scenarios will be described: 

 Manual operation of the individual functions in the WinCC overview picture. 

 Creating and starting a cleaning batch from the SIMATIC BATCH Control Center 

 Creating and starting a cleaning batch with the SIMATIC BATCH controls directly 
from WinCC Runtime 

6.2 Scenario A 

Description 

Handling the plant in manual mode is explained in this scenario. Here you will be 
able to operate the individual components of the CIP system and e.g., carry out an 
adjustment of the detergent concentration in the detergent tank. 

The following instructions describe starting the reprocessing of the washing fluid in 
the detergent tank. 

Requirement 

The following points are a prerequisite: 

 WinCC Runtime is active 

 The S7 program is loaded in "S7-PLCSIM" and the key switch is set to Run (-P) 

Procedure 

1. Open the plant overview picture for the CIP system. 
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2. Click on the "Faceplate" button in the “Detergent/DETERGENT" SFC control. 

 

 

 

The faceplate for the “Detergent/DETERGENT" SFC opens. 

3. Click on the "Start" button. 

 

 

4. Confirm the "SFC operation" dialog with "OK". 
The SFC starts and adjusts to the setpoint values. 



6 Operation and control of the Application Example 

6.2 Scenario A 
 

CIP - Cleaning in Place 
Entry ID: 78463886,    V3.0,    09/2016   108 
 


 S

ie
m

e
n

s
 A

G
 2

0
1

6
 A

ll 
ri

g
h

ts
 r

e
s
e

rv
e

d
 

5. Open the detergent tank valve. 

 

 

The valve opens. 

6. Start the pump at 100% speed. 

 

 

 

The pump runs at 100%. 

7. Observe the measured values and the SFC “Detergent/DETERGENT”. 
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The removal of fluid causes fresh water to be added. This changes temperature 
and detergent concentration. The SFC “Detergent/DETERGENT” adjusts the 
measured values to the stated setpoints. This guarantees that fluid of the correct 
quality is always available. 

6.3 Scenario B 

In Scenario A you became acquainted with the individual functions of the CIP 
system in manual operation. In the following, how to use these functions with 
SIMATIC BATCH will be described. Here, operation is carried out from the 
SIMATIC BATCH Control Center. 

Requirement 

The following points are a prerequisite: 

 WinCC Runtime is active 

 The S7 program is loaded in "S7-PLCSIM" and the key switch is set to Run (-P) 

 The SIMATIC BATCH server is in the "Run" state 

 The "DETERGENT" SFC is in the "Run" state (active "LEVEL CHECK" step) 

 The supplied backup has been imported 

 Role management has already been carried out 

 

Procedure 

1. In the key area, click on the "Key set change" button. 
 

 
 

2. In the key area, click on the "BATCH Control Center" button. 
 

 

 

The SIMATIC BATCH Control Center opens. 

Right-click on "Orders" and select the "New" menu command. 
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This opens the "Generate order category" window. 

3. In the “Names" tab, enter a suitable name (e.g. CIP). 

4. Click on the "OK" button. 

5. Right-click on “CIP" and select the "New" menu command. 
The "Create job" window opens. 

6. In the "General" tab, enter a suitable name (e.g. CIP MIXER) in the "Names" box. 

7. Switch to the "Batches" tab. 

8. Click on the “New” button. 
The "Formula or master recipe selection" window opens. 

9. Select the "CIP MIXER V1.0" master recipe. 

10.  Click on the "OK" button. 

 

 

11. Give the batch in the "Create order" window a suitable name. 

12. Click on the "OK" button in the "Create job" window. 

You have now created a new order with a batch. 

 

13. Right-click on the batch and select the "Release" menu command. 

14. Confirm the dialog window that opens with "Yes". 

15. Double-click on the batch. 
The control recipe will be displayed for you. 

16. Right-click on the batch and select the “Start" menu command. 

17. Confirm the dialog window that opens with "Yes". 
The batch starts. SIMATIC BATCH now occupies the plant sections and starts 
the SFCs. All the control strategies are completed one after the other. 

18. Switch to WinCC Runtime and observe the individual valves and pumps being actuated. 
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19. Switch to the “Mixer" process picture. 
Here also the valves and the pump on the mixer are actuated. 

The batch is exited automatically. The SFCs that were started are terminated and 
reset to the "IDLE" state by SIMATIC BATCH.  

 

6.4 Scenario C 

In Scenario A you became acquainted with the individual functions of the CIP 
system in manual operation. In the following, how to use these functions with 
SIMATIC BATCH will be described. Operation takes place here in WinCC Runtime 
via the SIMATIC BATCH OS controls (BATCH OCXs). 

Requirement 

The following points are a prerequisite: 

 WinCC Runtime is active 

 The S7 program is loaded in "S7-PLCSIM" and the key switch is set to Run (-P) 

 The SIMATIC BATCH server is in the "Run" state 

 The "DETERGENT" SFC is in the "Run" state (active "LEVEL CHECK" step) 

 The supplied backup has been imported 

 Role management has already been carried out 

 The order has been created in SIMATIC BATCH Control Center 

Procedure 

1. Open the "RECIPE CONTROL" screen in WinCC Runtime. 

2. Right-click on the "UT_CIP_MP" project in the "SIMATIC BATCH OS Master" 
BATCH OCX. 

3. Select the "Connect project" menu command. 

 

 

4. Right-click on the button next to “Formula” in the "SIMATIC BATCH OS Batch 
Creation" BATCH OCX. 

5. Select the "CIP Mixer V1.0" recipe in the "Select recipe/formula" window. 

6. Click on the "OK" button. 
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7. Right-click on the button next to “Order category” in the "SIMATIC BATCH OS 
Batch Creation" BATCH OCX. 

8. Select the order "CIP MIXER" (needs to have been created previously in 
BATCH Control Center) in the "Select order" window. 
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Click on the "OK" button. 

 

 

 

 

 

9. Enter a suitable name in the "Name" box in the "SIMATIC BATCH OS Batch 
Creation" BATCH OCX. 

10. Adjust the start time in the "SIMATIC BATCH OS Batch Creation" BATCH OCX. 

11. Right-click on the “Release batch (es)” button in the "SIMATIC BACH OS 
Batch Creation" BATCH OCX. 

12. Click the “Yes” button in the “Confirm” dialog box. 
The batch is released. 
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13. Right-click on the “SIMATIC BATCH OS Process Cell” BATCH OCX on the 
batch that you had previously created. 

14. Select the menu command “Start batch”. 

 

 

15. Click the “Yes” button in the “Confirm” dialog box. 

16. You can see the plant sections occupied by the batch in the "SIMATIC BATCH 
OS Allocation" BATCH OCX. 

17. Double-click one of the occupied plant sections. 
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In the "SIMATIC BATCH OS Properties" BATCH OCX the control recipe is displayed. 

 

 



7 References 

 

 

CIP - Cleaning in Place 
Entry ID: 78463886,    V3.0,    09/2016   116 
 


 S

ie
m

e
n

s
 A

G
 2

0
1

6
 A

ll 
ri

g
h

ts
 r

e
s
e

rv
e

d
 

7 References 

 

 Topic 

\1\ Siemens Industry Online Support 

https://support.industry.siemens.com 

\2\ Download page of this entry 
https://support.industry.siemens.com/cs/ww/de/view/78463886 

\3\ SIMATIC PCS 7 in the Industry Online Support – Overview page 
https://support.industry.siemens.com/cs/ww/en/view/63481413 

\4\ SIMATIC Process Control System PCS 7 Compendium Part C – Technical Functions with 
SFC Types 
https://support.industry.siemens.com/cs/ww/en/view/109098121 

\5\ SIMATIC Process Control System PCS 7 SIMATIC BATCH V8.2 
https://support.industry.siemens.com/cs/ww/en/view/109485956 

\6\ SIMATIC Process Control System PCS 7 PCS 7 BRAUMAT Library V7.1 
https://support.industry.siemens.com/cs/ww/en/view/60307664 

\7\ SIMATIC Process Control System PCS 7 Logic Matrix 
https://support.industry.siemens.com/cs/ww/en/view/109737083 
 

\8\ Efficient Configuration of Interlock Logics with PCS 7 Logic Matrix 
https://support.industry.siemens.com/cs/ww/en/view/109482621 
 

 

 

 

8 History 
 

Version Date Modification  

V1.0 10/2013 First edition 

V2.0 02/15 Updating to PCS 7 V8.1 

V3.0 08/2016  Update to PCS 7 V8.2 

 Implementation of PCS 7 Logic matrix 

 Process tags on the basis of CMTs 

 Simulation on the basis of CFCs 

 SFC calculations 

 

https://support.industry.siemens.com/
https://support.industry.siemens.com/cs/ww/de/view/78463886
https://support.industry.siemens.com/cs/ww/de/view/63481413
https://support.industry.siemens.com/cs/de/de/view/109098121
https://support.industry.siemens.com/cs/ww/de/view/109485956
https://support.industry.siemens.com/cs/ww/de/view/60307664
https://support.industry.siemens.com/cs/ww/de/view/109737083
https://support.industry.siemens.com/cs/ww/de/view/109482621

	PCS 7 Unit Template "CIP Cleaning in Place"
	Warranty and liability
	Table of contents
	1 Automation Task
	2 Automation Solution
	2.1 Overview of the complete solution
	2.2 Core functionality
	2.2.1 Description of the individual functions
	2.2.2 PI process screen

	2.3 Hardware and software components used

	3 Basics
	3.1 Process engineering
	3.2 Automation technology

	4 Structure and Principle of Operation
	4.1 Project structure
	4.1.1 CFC chart naming convention
	4.1.2 Technological view

	4.2 Technical functions and process tags
	4.2.1 CIP SUPPLY
	4.2.2 CIP RETURN
	4.2.3 Detergent tank
	4.2.4 Post-rinse tank
	4.2.5 Pre-rinse tank
	4.2.6 Mixer
	4.2.7 Mixer supply (TANK_IN)
	4.2.8 Mixer sequence

	4.3 Interlocks
	4.4 Sequences (SFC type instances)
	4.4.1 CIP_RETURN
	4.4.2 CIP_SUPPLY
	4.4.3 FILL_HEAT_CONC
	4.4.4 TANK_IN
	4.4.5 Tank_OUT

	4.5 SIMATIC BATCH
	4.5.1 Cleaning recipes
	4.5.2 Cleaning batches


	5 Starting the Application Example
	5.1 Preparation
	5.2 Working on the multiproject
	5.3 Commissioning

	6 Operation and control of the Application Example
	6.1 Overview
	6.2 Scenario A
	6.3 Scenario B
	6.4 Scenario C

	7 References
	8 History

